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SnapPlus
Wisconsin’s Nutrient Management Software

8 basic steps to developing a   
nutrient management plan using SnapPlus

1.	 Install and open the current version of SnapPlus.

Save Snapshot saves your SnapPlus farm at a specific 
point in time. This gives you the option to revert the 
file back to that point during a session if needed. You 
can save multiple snapshots, so do it often! 

SnapPlus Tip: SnapPlus auto-fills most of the NM 8 590 Checklist Report.  
It is the responsibility of the plan writer to review the checklist and check boxes that SnapPlus does not fill. See the  

NM checklist and tips section on pages 24-27 for more information. Electronic signatures are accepted on this report.

5 basic steps to updating a 
nutrient management plan using SnapPlus
When updating, it’s important to remember to plan for next 
fall’s manure applications in the future year. This will help you 
anticipate problem areas and address potential compliance 
issues before they have already occurred.

1.	 Before making any changes, save a Snapshot.

2.	 Update previous year’s cropping data, fertilizer, and 
manure applications for each field by using the 
Cropping Grid. To access click on the plant icon 
in the upper left portion of the screen.  

3.	 Add any new crops, soil tests, field, crop or nutrient 
information using the Farm, Soil Tests, SnapMaps, Fields 
and Nutrients Screens.

4.	 Update crop and nutrient application information for 
the current year and future year for each field.  

5.	 Run the Reports from the Reports screen; review and 
correct problems. Suggested reports include Nutrient Mgmt Reports 
(NM2,NM3, NM6 & NM8) and Farm Mgmt Reports (FM2 & FM3).

6.	 Archive your files using the File Menu>Archive. 

Download SnapPlus for free!  

snapplus.wisc.edu
Click the menu tab>DOWNLOADS

Select DOWNLOAD SNAPPLUS 20  
from the dropdown menu. 

Click the Build link

Open the downloaded exe. file and follow 
through the steps in the Install Wizard.  

If you have a new computer that isn’t allowing the 
download of the SnapPlus program to complete,  
see page 4 for instructions.

Quick Guide

2.	 Create a new farm on the Farm Screen.  

3.	 Import your soil tests on the Soil Tests Screen.

4.	 Draw your fields & enter field data on SnapMaps.

5.	 Enter nutrient sources on the Nutrients Screen.

6.	 Enter crop & nutrient application information  
using the Rotation Wizard and Cropping Screen.

7.	 Run the Reports from the Reports screen; review 
and correct problems. Suggested reports include Nutrient Mgmt 
Reports (NM2,NM3, NM6 & NM8) and Farm Mgmt Reports (FM2 & FM3).

8.	 Archive your files using the File Menu>Archive. 

Archive can save a file as either a compressed .zip 
file or a .snapDB file. Both file types are appended 
with a time-stamp to the name. Recommended for 
historical/reporting purposes or as a back-up. 

QUICK GUIDE	

http://snapplus.wisc.edu


Check out the What’s New 
topic for the latest additions! 

Videos are a great way to review 
or learn a new task!   

For a complete list, see the 
next few pages.

snapplus.wisc.edu

•	Overview

•	Meet the Team

•	Contact Us

•	Download 20

•	What’s New in 
SnapPlus 20

•	Installation Details

•	Download SnapPlus 
19 Beta

•	Manure Tracker App 
from IPCM

•	How to Videos

•	Answers (FAQ)

•	SnapPlus 
Training Manual

•	SnapPlus 19 Web 
Help

•	SnapPlus 20 
Web Help

•	NM Resources

•	NM Data Dictionary

•	Soil Details 

•	Soil Details - 2017/2018

•	Matching SnapPlus Tillages

•	MRTN Update (2010 Version)

•	Converting Organic By-
Product Analysis into a 
SnapPlus Application Rate

•	Water Quality Trading

•	DATCP Certified Soil Testing 
Laboratories

The website is a great resource!  

•	Facebook Page

•	Follow Us on Twitter

•	YouTube Videos

Want to attend a training?
For upcoming trainings & other offerings 
from DATCP, scan or click the QR code.

A full version of the 
help system within 
SnapPlus is available 
on the website!  
No need to have 
SnapPlus open!

Check out DATCP’s  
nutrient management website!

SnapPlus Help Search Tip:  
Just type SnapPlus and the 
topic in your web browser!

Want to learn more about the  
fundamentals of nutrient management? 
Check out the self-paced, online  
UW Nutrient Management Farmer Curriculum at:

go.wisc.edu/nmfe

Or contact the NPM Program!  
For a list of regional contacts:
https://ipcm.wisc.edu/npm-fast-facts-magazine/

Still need help?
For SnapPlus training or nutrient management issues, 
contact DATCP’s: 

Andrea Topper: 608-405-0235, Andrea.Topper@wisconsin.gov 
Cody Calkins: 608-224-4604, Cody.Calkins@wisconsin.gov

For information on the WI Phosphorus Index, 
contact UW Soils SnapPlus team:

Laura Ward Good: 608-262-9894, lwgood@wisc.edu
Hava Blair: 608-265-9354, hkblair@wisc.edu

https://datcp.wi.gov/Pages/Programs_Services/NutrientManagementTraining.aspx

The Department of Agriculture, Trade and 
Consumer Protection’s website is a great 
resource for information on cost-share,  
NM updates, trainings and more! 

This publication is available from the 
Nutrient and Pest Management Program. 
Contact us at: npm@extension.wisc.edu
or vist our website (ipcm.wisc.edu) 

November 2023 -2M
NPM

Have a question about SnapPlus?

Then ask it!  
support@snapplus.wisc.edu

Website and resources	 2
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What is SnapPlus?

Cropping Screen Basics

Downloading and Installing the 
SnapPlus Program

Understanding Yield Goals, 
Tillage, Lime and MRTN  

Getting Started on the Farm Screen

Planning Manure and Fertilizer  
Applications

Importing Soil Sample Test Results 
[if you have shapefiles, import these first (see video 8), then 
come back to this step]

Planning for all Fields by Year  
Using the Cropping Grid

Getting Started in SnapMaps

Rotation Wizard 1:  
Crop Rotations

Navigating SnapMaps’  Tools

Rotation Wizard 2:  
Applying Crop Rotations to Fields

Drawing Field Boundaries

Rotation Wizard 3:   
Editing Applications

Importing Shapefiles

Reviewing Total Planned Manure 
Applications by Year and Season 

Importing Select Information from 
SnapMaps to your SnapPlus Farm

Checking That a Completed Plan 
Meets Guidelines    

Field Screen Basics

Nutrient Screen Basics

Entering Manure and Biosolids

Entering Fertilizers   

Estimating Manure Annual Volumes   

Introduction to 
SnapPlus Playlist
This playlist is recommended as a starting 
point for new users. 

Introduction to 
SnapPlus 

SnapMaps Tutorials

SnapMapsTutorials 
Playlist

5

1

6

2

7

8

3

4

Dismissing and Restoring a SWQMA

Splitting a Field

Create a PDF Map

Create a Multiple Area PDF Map

Editing Field Boundaries

Adding Concentrated Flow Channels

Changing Field Labels

Creating a CAFO Spreadable 
Acres Map

How-to videos	 3
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https://youtu.be/BW-aXyCheQI
https://youtu.be/Hachgq0GSwg
https://youtu.be/Ad9LUwncFWc
https://youtu.be/pHuzf5wMMWQ
https://youtu.be/qiy4qyLoQcY
https://youtu.be/ehm6UFFodIM
https://youtu.be/B83fpqucIVY
https://youtu.be/HXRcY2Igq74
https://youtu.be/wiACA63zXOA
https://youtu.be/6HDsSPLKj7Q
https://youtu.be/oCHr_XCVTkA
https://youtu.be/0Bc1C8EipEc
https://youtu.be/9fK9EUWLknw
https://youtu.be/unOkKvCiGGU
https://youtu.be/Hue1D1Uycss
https://youtu.be/CjvbxeoUQe8
https://youtu.be/h3bPkK0R75I
https://youtu.be/k9097iQ2QfY
https://youtu.be/J_EDblY-1us
https://youtu.be/4Qw_FndPlzg
https://youtu.be/ksrHUNOEkzQ
https://www.youtube.com/watch?v=BW-aXyCheQI&list=PLhFkw4rJA7C-3EMEXi-4NMN-h3_bA-p1t
https://www.youtube.com/watch?v=4Qw_FndPlzg&list=PLhFkw4rJA7C9yWkNLLxlj9APLDkR7lH38
https://youtu.be/xcGXj03L5lo
https://youtu.be/aOV5Sm5ppJQ
https://youtu.be/GCda7xTrfiU
https://youtu.be/9jHQZN6hKCA
https://youtu.be/hliyeIu3PjU
https://youtu.be/TsLuUXNmleI
https://youtu.be/DusGIvgSnkk
https://youtu.be/SThT-winrDo


SnapPlus Additional Topics

SnapPlus Additional 
Topics Playlist
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Making Groups for Planning and 
Updating in the Cropping Grid

Rotation Wizard 4:   
Changing Planned Applications

Rotation Wizard 5:   
All Other Editing 

Adjusting MRTN

Using the Easy Group Builder

Using Nutrient Systems 

Exporting and Importing  
Farms, Groups and Subfarms

How to Enter Lab Analysis of   
Solid Biosolids

How to Use the Daily Log

How to Enter Lab Analysis of   
Liquid Biosolids  

Create and Import  
an MS Excel Document Daily Log 

SnapPlus Tips and Tricks! 

Creating Groups and Subfarms

Running the Phosphorus Index

Planning for Nutrients Spread by 
Grazing Animals

Calculating the Dollar Value of   
On-Farm Nutrients

Planning and Recording Lime  
Applications 

Click on the above logo 
or scan the QR code 
to subscribe to the 
SnapPlusUW channel 
on YouTube, so you 
never miss a new video!

Check out DATCPs new GIS Data Layer 
webpage for all the SnapMap layers 
planners might need! 
https://gis-widatcp.opendata.arcgis.com/

Do you see strange display behavior in SnapPlus, such 
as windows spontaneously resizing or text becoming 
very small when you click? 

The best fix for this issue is to close and re-open Snap-
Plus. The problem seems to occur most often on the 
Fields page. The cause of the issue is the way that the 
Windows operating system tries to resize SnapPlus  
fonts and grids.

Do you have a new computer that isn’t allowing the 
download of the SnapPlus program to complete? If so, 
follow these steps to disable S Mode on your computer:

1.	 Click on the Windows Start button > Settings> 
select the System Tab in the left-pane. In the right-
pane, scroll down and click on the About option.

2.	 On the About screen, scroll down and click on Prod-
uct Key and Activation Tab, located under Related 
Settings.

3.	 On the next screen, expand the S Mode entry and 
click on Open Store button. 

4.	 If you are not signed-in to your Microsoft Account, 
you will be prompted to Sign-in to Windows Store 
using your Microsoft Account.

5.	 On the next screen, click on the Get button to 
switch your computer out of S Mode.

6.	 Once S Mode is switched OFF, you will see a pop-
up, confirming that S Mode has been switched OFF 
and you can now install the SnapPlus program.

Having a technical issue with SnapPlus?
The SnapPlus website might have your answer! 
https://snapplus.wisc.edu/news-help/answers-faq/
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https://www.youtube.com/watch?v=-jK2DPhsuTg&list=PLhFkw4rJA7C8yHMyGszMgP3qa3W1z2yZj
https://youtu.be/KJuAe7wjKA8
https://youtu.be/q2D7zvGASEo
https://youtu.be/-jK2DPhsuTg
https://youtu.be/2MplKF0q4xE
https://youtu.be/jqp8ofPXz3Y
https://youtu.be/d-Q6mBSggv0
https://youtu.be/0hx_IUGJ4Dw
https://youtu.be/ERQPUX9-r-U
https://youtu.be/_ju8msiOZ_k
https://youtu.be/XjcGMYfodRI
https://youtu.be/iyT45yc1ezA
https://youtu.be/dbRpOsmGE5U
https://youtu.be/Skdk88Z9AzY
https://youtu.be/DmBHk5dRnls
https://youtu.be/Dbgufc7pLpw
https://youtu.be/zpUhwJa7XYM
https://www.youtube.com/user/SnapPlusUW
https://gis-widatcp.opendata.arcgis.com/
https://gis-widatcp.opendata.arcgis.com/
https://snapplus.wisc.edu/news-help/answers-faq/


SnapPlus tools to help you…
Add or edit information for multiple fields and years

Tools menu > Easy Group Builder creates new groups or 
Excel reports based on user selected criteria.

Tools menu > Farm Settings sets winter spreading strat-
egies for all fields or for field groups. On permitted farms, 
allows acknowledgement of proper planning for all fields.

Option to Clear all restrictions is helpful prior to a  
SnapMaps import to clear outdated restrictions or  
restrictions set by hand!

Tools menu > Nutrient System Editor creates a system 
or combination of fertilizer and manure sources that are 
used on a yearly basis for a crop that can be added to any 
cropping year and field throughout the database. 

Tools menu > Update All Fields forces a recalculation of 
nutrient recommendations, rotational soil loss, and P index 
for all fields. 

Tools menu > Rotation Wizard make changes to multiple 
fields and years (See page 10 for step-by-step instructions 
for adding crop or application data to fields):

 9 Change crop, yields, tillage, legume stand information for N 
credits or to add season notes, Change existing crop data or 
applications to fields > Cropping data

 9 Add/delete manure or fertilizer application, Change existing 
crop data or applications to fields > Application data

 9 Change spread method or rate for a planned application, 
Change existing crop data or applications to fields > 
Application>Edit existing

 9 Repeat past crop years’ management in planning for future 
years, Copy crop and application data to crop years

 9 Delete crop years, Delete crop & applications data from 
fields 

 9 Edit rotation length, start year, or information about contour 
or filter strips, Edit rotational settings for fields

 9 Edit the N price, crop price, MRTN price ratio, and MRTN range 
point for corn or wheat,  Edit MRTN data for fields

SnapPlus Tip:  When creating rotations in the Rotation Editor, you can just enter the abbreviations, and the full crop 
names will automatically be entered into the table. To see the abbreviations, click on the Crop Abbreviations button 
to see a list of the ones you selected on the farm screen. To see a full list of all crop abbreviations, go to the Help>Help 
Contents> The Rotation Editor and Rotation Wizard> Using the Rotation Editor> A Guide to Crop Abbreviations

Set up for grazing (see page 12 for more information)

Nutrients Tab > Grazing herd setup to build your herds. 

Nutrients Tab > Grazing herd setup > Grazing Est opens 
the Grazing application rate estimator. You can enter your 
herd, pasture size, days on pasture, and % of day spent 
grazing to get an estimated manure application rate in 
tons/acre for your situation. 

SnapPlus Tip: When using the Rotation Wizard 
to speed up the planning process, make a 
Snapshot first. If you make a mistake, you can select 
File>Revert to Last Snapshot to start again.

Update,  fine-tune  or view management information

View menu>Nutrient Applications by Season to find out 
if the plan distributes all manure when it is available, see 
page 7 for more information.

View menu>Cropping Grid Edit to switch the Cropping 
screen between the default one-field, all-years view and  
an all-fields, one-year view, which allows for easier entry of 
manure applications based on soil test/crop removal levels.

Fields tab>Groups subtab to designate a group of fields 
that need the same updates. Groups can be selected in the 
Rotation Wizard.

Records tab to update planned manure applications with 
actual application rates used. 

Help>Custom Excel Templates to create Daily Log  
Templates with field dropdowns or prefilled names/acres.

Find more information about how to use 
these tools in the Help menu!

Tools menu > Rotation Editor builds rotation templates that can be reused multiple times in the Rotation Wizard.

5
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Let’s talk cropping years
A calendar  year runs from January to December.

JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC

A cropping year generally runs from harvest to harvest and varies from field to field based on the crop rotation.

NOV DEC JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV DEC JAN FEB MAR APR MAY JUN JUL AUG SEP OCT NOV

CROPPING YEAR 1 CROPPING YEAR 2

?
Sub-farms can be used to identify fields that are 
located together geographically, fields that share 
the same manure sources, or rented fields with the 
same owner. Fields may only be in one sub-farm.

What’s the difference between groups and sub-farms?

For a field, the new cropping year starts after the previous crop has been harvested and spans the time to the next harvest.

Importing soil samples
Make sure to have a .CSV or .XLSX file of your soil test data 
for easy import into SnapPlus.  If you don’t have a .CSV or 
.XLSX file call your Soil Lab to ask for one to be emailed to you.

If updating soil tests in an existing database, take caution 
that all field names are correct. A pop-up will appear and 
provide a list of field names that are “new”, if that happens 
click close. SnapPlus will show you all the soil test data and 
highlight the field name cells orange if that field name doesn’t 
currently exist in the database. To alter field name, click on the 
orange field name cell and type in correct field name. If multi-
ple samples for the same field, SnapPlus will ask if you want to 
update all “new” field names with the correct field name.  

SnapPlus Tip:  To adjust UW recs to reflect 
current soil nitrate test results, go to the 
Cropping Screen and click on a cell in the 
UW Recommendation row to open the 
Nutrient Recommendation Details dialog 
box. Click on the cell in the Adjustment row 
to record the new data.

SnapPlus Tip:  To record lime applications, 
go to the Cropping Screen and click on a 
cell in the Lime Rec row.

Groups can be used to logically organize fields by any 
means that might be useful. Fields may be in more 
than one group. Groups can also be used to reduce the 
number of fields displayed on the Fields Screen or in 
the Rotation Wizard. 

Example 3b: If a winter wheat field is harvested in July, 
manure is applied, and then a cover crop is planted; enter 
the manure as a fall application in the following cropping 
year because no nutrients are recommended for a  non-
harvested cover crop, and the nutrients should be counted 
as contributing to the next crop.

Example 4a: If manure is applied to established hay 
between cuttings, the application should be entered as a 
summer application in the current year.

Example 4b: If manure is applied to hay after the last 
cutting of the year, that application should be entered as as 
a fall application in the following crop year.

Example 1: If a soybean field is harvested in October, and 
manure is applied following the harvest; enter the manure 
as a fall application of the following cropping year because 
the nutrients will be used by the crop harvested in the 
following year. 

Example 2: If a corn silage field is harvested in September, 
and the field is limed and tilled following the harvest; count 
the lime application and the tillage as part of the following 
cropping year.

Example 3a: If a winter wheat field is harvested in July, 
manure is applied, and a forage crop is planted (a double 
crop), enter the summer manure application in the current 
cropping year because the nutrients are going to the 
forage crop.
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For a field, the new cropping year starts after the previous crop has been harvested and spans the time to the next harvest.

In order for SnapPlus to identify if there is adequate acreage for manure 
produced and/or applied on the 590 Checklist, planners must have all 
manure allocated for the current year in addition to one past year 
and one future year.

SnapPlus Tip:  Don’t forget to add the spreader 
calibration method. On the Farm Screen, click 
the Document Spreader Calibration Methods 
button and select all that apply.

Entering nutrient rates for biosolids, 
wastewater, and organic by-products
Q: How do I enter a sewage sludge (biosolids) or organic 
waste analysis if the lab report does not give the units in 
lb/ton or lb/1000 gallons?   

A: If you have a typical lab report for biosolids, this will not 
be difficult. Select the appropriate biosolids or organic waste 
type in the Manure Bio Source Data table on the Nutrients tab, 
and then click on any cell in the analysis row. A box will pop up 
that will convert data from the lab report to lb/ ton or lb/1000 
gallon. For step-by-step instructions, go to the SnapPlus Addi-
tional Topics playlist (pg 4) and watch videos 13 & 14. 

You may get an analysis for an organic amendment that does 
not report the nutrient content in the same  “% of dry matter” 
or “% of solids” units required in the SnapPlus Biosolids analysis 
entry. You will need to convert the results to these units using 
the reported solids content. Sometimes a wastewater-type 
analysis does not include any measurement of the solids 
content, and, in those cases, you cannot use the SnapPlus 
analysis entry boxes. You can still calculate the lb/1000 gallons 
of N, P2O5, and K2O, however, if concentrations are given for 
these nutrients. Instructions for converting various types of lab 
reports can be found on the SnapPlus website under Planning 
Information>Converting-Analysis-of-Organic-By-Products-to-
N-P2O5-K2O-Rates.pdf 

The Nutrient Application by Season table
To open the Nutrient Application by Season Tool, click on 
the icon of the wheat head in the orange box   next 
to the Help in the main menu bar at the top of the page.

The dialog box displays the total amounts planned or 
actual for each nutrient source by season. Selecting the 
nutrients to display at the bottom will turn off or on 
certain nutrient types. The annual amounts available, 
planned and remaining are also displayed. The amounts 
available are taken from the Manure/Bio Data table on 
the Nutrient Sources screen. The label in the lower right 
shows the number of acres that have applied manure. This 
dialog box will stay up as you move around from screen 
to screen in SnapPlus. When you make applications from 
the Cropping Screen this dialog will be visible but you will 
not be able to access it to change any settings.  The same 
is true when you are using the rotation wizard.

The Nutrient Screen subtabs

 ; Nutrient Sources
Use the Nutrients>Nutrient Sources subtab to 
enter each manure source (for example, pit manure, 
bedded pack, grazing manure) into the Manure/ 
BioSources Data table.

You can also have SnapPlus auto-calculate the 
value of the manure in the plan. Just enter the 
price per pound of nitrogen, phosphorus and 
potassium in the Value of Manure table (located 
to the right of the Manure/BioSources Data table). 
SnapPlus uses the Known Manure Volume to  
calculate both a Per Unit $ and Total Value $. 

 ; Manure Production Estimator
Estimate how much of each manure type by using 
the Nutrients>Manure Production Estimator> 
Livestock Manure Production Estimator table by 
clicking the green plus sign to add each animal type. 
Tip: Click on the Add All Beef or Add All Dairy to  
instantly add multiple animal types.

For each animal type, enter in:
 9 Number of Head
 9 Total Number of Days
 9 % Collected and Spread as Solid
 9 % Collected and Spread as Liquid

Once the data is entered in the table, the  
Farm Totals for all manure will be displayed.

On the same page are the Manure Storage and the 
Manure Spreader tables which can also be used to 
estimate manure quantity for the farm.

 ; Manure Analysis
Use the Nutrients>Manure Analysis subtab to 
import manure analysis data. It is important to 
remember in the Import Manure Analysis dialog box 
to click the Import to SnapPlus button. Then when 
back on the Manure Analysis subtab, click the Save 
Selected to Nutrient Source button.  

Manure analyses are not required for 590 farms but 
are highly encouraged. SnapPlus by default will 
auto-populate nutrient sources with associated book 
values for nitrogen, phosphorus and potassium.  

7
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Note:  Not all tillage options are used for all crops in SnapPlus because some crops are not typically grown with the full range 
of tillage systems.

SnapPlus tillage codes and explanations
SnapPlus uses the most soil-disturbing tillage option selected in the RUSLE2 database for each primary tillage 
category. If you meet “T” with SnapPlus, then you are protecting the field from excess soil erosion. Fall and spring 
chisel and moldboard options listed include multiple tillage passes.

Code Tillage RUSLE2 operations (assumptions for soil loss calculations)

NTg No-till green No soil disturbance except for planter using a double-disk opener and fluted 
coulter. Spray operation kills previous cover crop the day before planting. 

NT No-till No soil disturbance except for planter using a double-disk opener  
and fluted coulter. 

ST Strip-till No soil disturbance except for 30% of the surface at planting with a strip-till 
planter.

SVT
1-pass

Spring vertical tillage Spring pass using a seedbed conditioner with a double gang coulter caddy, 
rotary harrow, and rolling basket incorporator.

FFC
1-pass

Fall cultivation One field cultivation in the fall with no spring tillage.  
Use for fall one-pass systems.

SFC
1-pass

Spring cultivation One field cultivation before planting, use for most 1-pass systems.

FVT
2-pass

Fall vertical tillage Fall pass plus a spring pass with same seedbed conditioner: double gang 
coulter caddy, rotary harrow, and rolling basket incorporator.

FCND
2-pass

Fall chisel, 
no disk Fall chisel plowing (twisted shovel) and field cultivation before planting.

SCND
2-pass

Spring chisel,  
no disk

Spring chisel plowing (twisted shovel) and field cultivation  
before planting.

FCD
3-pass

Fall chisel, disked Fall chisel plowing (twisted shovel) with spring disking (tandem) and field 
cultivation before planting. 

SCD
3-pass

Spring chisel, disked Spring chisel plowing (twisted shovel) followed by disking (tandem)  
and field cultivation before planting.

FP
3-pass

Fall 
moldboard plow

Fall moldboard plowing with spring disking (tandem) and field cultivation 
before planting.

SP
3-pass

Spring  
moldboard plow

Spring moldboard plowing followed by disking (tandem) and field cultivation 
before planting.

SnapPlus Tip:  If the tillage you are using isn’t in SnapPlus, you can select the most similar SnapPlus 
system by comparing the STIR values. Go to PLANNING INFO>MATCHING SNAPPLUS TILLAGES 
on snapplus.wisc.edu for more information.

inc
re

as
ing

 so
il d

ist
ur

ba
nc

e v
alu

e

Use Diversified vegetables for nutrient management planning for small scale-vegetable growers.

In response to the difficulties farmers growing a wide variety of vegetables on small acreages have in doing a 
nutrient management plan, SnapPlus has crop selections called “Diversified vegetables”. 

Diversified vegetables can be used whenever multiple crops are grown in rotation. There are three tillage options: 
tilled (6 passes in year), tilled with plastic mulch (3 passes), and tilled with organic mulch (3 passes). Where only one 
crop is grown per year, planners can use the Diversified vegetables (single crop), which has both 3-pass and 2-pass 
chisel plow tillage choices including ones with plastic or organic mulch.  Diversified vegetable crops in SnapPlus use 
the UW-A2809 recommendations for “Truck crops”.

Tillages should be entered by cropping year, not 
calendar year. See the Let’s talk cropping years  
section on page 6 for an explanation & examples.
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Maximum allowable Nitrogen application for crops  
other than MRTN or legume crops

Maximum N rate ( N lb/a)1

All N from manure/legume credits  1.2x UW recs
Commercial N UW recs

Excess nitrogen applications
Maximum allowable Nitrogen application for corn

The maximum allowable N rate for corn is set at the high end of the range for 
the 0.05 Corn: N price ratio. These are the highest N rates in the UW-Extension 
guidelines and are recommended where manure and legume credits provide 
all the corn crop’s nitrogen needs.

Soil group: Yield Potential
Previous crop Maximum N rate (lb/a)1

Loamy: High yield potential soils
Corn, forage legumes, legume vegetable, 
or green manures

210

Soybean or small grains 160
Loamy: Medium yield potential soils
Corn, forage legumes, legume vegetable, 
or green manures

160

Soybean or small grains 150

Sands/loamy sands
All crops-irrigated 230
All crops-not irrigated 150
1 Includes Legume credits, Manure credits, This year’s manure and This year’s fertilizer.  
Note:  If the entire amount shown here is supplied through organic sources, some starter N fertilizer 
(up to 20 lb N per acre) can be applied before the SnapPlus warning notices are given.

Maximum allowable Nitrogen application for wheat

Soil group
Previous crop

Maximum N rate ( N lb/a)1 
Winter wheat Spring wheat

Loamy2

Corn, forage legumes, legume 
vegetable, or green manures

 85 75

Soybean or small grains 65 55
Sandy (sands/loamy sands) 
-All crops

115 105

Organic-All crops 0 0
2 Soils in the loamy group that have less than 2% organic matter (OM) use the sandy group 
maximum allowable N rate. Loamy soils with greater than 10% OM have maximum allowable 
N rates that are 30 lb N per acre lower than those shown in the table.

Maximum allowable 1st year manure Nitrogen 
application rates for  

legume & (legume + companion) crops3

Yield range
Manure N 

allowed (lb/a)1

Alfalfa; alfalfa/brome; red 
clover; or trefoil, birdsfoot, 
seeding or established

<1.5 ton/a 50

1.5 - 2.5 ton 100

2.6 - 3.5 ton 155

3.6 - 4.5 ton 205

Barley for grain underseeded 
with alfalfa, alfalfa/brome, or 
red clover seeding

All yield levels, bu/a 150

Dry beans

10-20 cwt 75

21-30 cwt 125

31-40 cwt 175

Oats for grain underseeded 
with alfalfa, alfalfa/brome,  
or red clover seeding

All yield levels, bu/a 140

All pastures that include 
legumes

0.5-1.9 ton 55

2 -3 ton 115

3.1 - 4.0 ton 160

4.1 - 5.0 ton 205

Small grain silage  
underseeded with alfalfa

2 - 3.5 ton 170

Small grain & legume silage 2 - 3.5 ton 70

Small grain & legume silage 
underseeded with alfalfa

2 - 3.5 ton 170

Soybean forage 2-3.5 ton 170

Soybean, grain and  
grain + straw

15-25 bu 75

26-35 bu 115

36-45 bu 155

46 bu or greater 195

3 Some SnapPlus legume crops such as peas and snap beans are not included in this table 
because N removal in the harvested portions of the crop is similar to their N fertilizer  
recommendation.

SnapPlus Tip:  Note: The 590 Standard does not allow 
commercial fertilizer N applications where there is no N 
recommendation, as is the case with most legume crops. 
However, due to the difficulty that sometimes occurs in 
obtaining N-free P2O5 or S fertilizers, SnapPlus does not 
give an excess N warning if up to 70 lb of the legume 
N allowance is applied as commercial fertilizer if that 
fertilizer includes required nutrients.

Tillages should be entered by cropping year, not 
calendar year. See the Let’s talk cropping years  
section on page 6 for an explanation & examples.

Excess N application info	 9
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The Rotation Wizard is a tool in SnapPlus that can help you 
save time by entering data for multiple years and crops. 
Before working with the wizard, go to File and click on 
Save Snapshot. Then if you make a mistake using the 
wizard, you can click on Revert to Last Snapshot to return 
to your original file. 

1. Open the Rotation Wizard either from the  
Cropping Screen or from the Tools menu.

2. You are in Step1 of the Rotation Wizard.  
Use the default selection > Add crop or application 
data to fields.  Click Next.

3. You are in Step 2 of the Rotation Wizard. Select Edit 
Rotation. You are now in the Rotation Editor. 

Quick Note:  A good method for naming is to use crop abbreviations, 
for example cg-csl-cg-abs-ab-ab-ab.  Using the correct abbreviations 
will automatically fill-in the crop names in the next step.  To access 
the abbreviations list, click on Crop Abbreviations and make note 
of the crops in your rotation.  

4. Click on the plus sign icon to create a new rotation.

A naming dialog box will open where you can type the name of the new 
rotation. Once named, it can be edited, copied, renamed or deleted.

5. If you used the crop abbreviations, the table will be 
filled in (go to the step 6). 

If not, just click on the plus sign icon under Rotation Years to add 
a line to the table, then select the crop from the dropdown menu.  
Continue until all the years of the rotation are completed. If the 
desired crops aren’t listed, then you must go back to the Farm Screen 
to select them for your farm.

6. Use the dropdown menus to fill in Yield Goal and 
Tillage for each year of the rotation. Also, check the 
Irrigated box if appropriate.  

Tillage explanations can be found in the SnapPlus Help by  
clicking on the  and searching for tillage. 

7. To add nutrient applications, select a year in the top 
table, then click on the plus sign icon below and use 
the dropdown menus to fill in each cells of that row.  
Repeat for each year of the rotation. Click Close.  

One suggestion for making your fertilizer plan easier to implement is 
to enter only manure applications during this step.  Once the on-farm 
nutrients are entered, you will be able to view the adjusted UW recom-
mendations and add Fertilizer applications accordingly.

8. You are back in Step 2 of the Rotation Wizard.  
Choose the fields (or groups or subfarms) that will use 
the new rotation and move them to the box on the 
right. Click Next.

9. You are now in Step 3 of the Rotation Wizard. 
Your goal in this step is to tell the program where each 
field is in the rotation in the given year. You also have 
the opportunity to identify fields that are farmed on the 
contour, strip-cropped or have filter strips.

Use the dropdown menus along with the Rotation Info 
at the bottom of the dialog box. Fill in the information 
for each field row, making sure to set the Start Year and 
Year in Rotation. When completed, click Next.  

To change multiple rows within a column at one time, select ALL 
until the grid is blue. Then left click on the column header and select 
value to change all rows.  

For rotations with alfalfa, we recommend that the start year goes 
back two growing seasons for carry-over legume credits.  So if you are 
planning for 2024, then start your rotation in 2022 to account for any 
legumes grown two years prior. For rotations with soybean, go back 
one year to account for the legume credit.

10. You are in Step 4 of the Rotation Wizard.  
This step allows you to make adjustments to applica-
tions pre-assigned to each cropping year, or you can 
delete them as needed. 

Use the dropdown menus to select the Season and 
Spread Method for the nutrient applications listed.  Use 
the plus sign or minus icon to add or delete applica-
tions. When completed, click Next.  

11. You are in the Confirm step of the Rotation Wizard. 
Review the information listed to confirm if it’s correct. If 
so, Click on Apply & Continue if you want to stay in the 
Wizard or Apply & Exit to return to the main screen.  If 
you would like to make edits, click on Back.   

The rotation wizard	 10
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On the Cropping Screen, SnapPlus flags problem applications in  This Year’s 
Manure or This Year’s Fertilizer. Red boxes indicates a N over-application 
and orange means a 590 planning problem. Click on the box to learn why the 
application was flagged. Here are some examples!

Orange flag: This plan uses purchased fertilizer to apply 
more P2O5 than is recommended for the crop rotation on 
this field. Reduce or eliminate P2O5 fertilizer on this field.

590 Standard: Commercial P2O5 should not be applied to a field in 
excess of any year’s recommendation if the total recommended for the 
rotation has already been applied. Corn can get 20 lb/acre starter.
How this is calculated in SnapPlus: P2O5 recommendations are 
summed for the entire rotation.  Then the total P2O5 amount applied 
(as manure and fertilizer) is added for each consecutive year. When the 
amount applied exceeds the recommendation for the rotation and the 
amount recommended for the individual crop year is also exceeded, 
then P2O5 fertilizer applications are flagged (except those of 20 lb/acre 
or less for corn).

Orange flag: P2O5 applied as starter to corn should be 
applied at planting and placed subsurface with, or in a 
band in close proximity to, the seed.

590 Standard: Up to 20 pounds per acre of P2O5 starter fertilizer may 
be applied to corn grown on soils testing excessively high, where no 
fertilizer is recommended.
How SnapPlus identifies this problem:  When adding starter in the 
nutrient application planner SnapPlus checks to see the placement of 
the fertilizer. If the user chooses spread method as subsurface, Snap-
Plus identifies the application as a starter and will not flag.

Orange flag: One or more applications are not compati-
ble with ‘none’ or ‘no till’ selected.

How to fix the problem: This message indicates a data entry prob-
lem with a manure or fertilizer Spread method of Incorporated which 
is not possible with a crop year tillage of no-till or none. Tillage choice 
needs to be updated.

Orange flag: Winter manure P2O5 applications exceed 
this year's crop removal by __ lbs. 

590 Standard: On frozen or snow-covered soils, do not exceed the  
P removal of the following crop when applying manure.
How SnapPlus identifies this problem: SnapPlus will flag once a 
winter manure application exceeds the P2O5 removal of the following 
crop. User must reduce rate of manure applied during winter. 

Orange flag: The liquid manure application rate exceeds 
the rate allowed for a single application in the SWQMA, 
or an unincorporated liquid manure application on this 
tiled field exceeds the maximum rate of 12,000 gal/acre.

590 Standard: When unincorporated liquid manure and/or organic 
by-products applications with ≤ 11.0% dry matter occur on non-frozen 
soils within a SWQMA, OR where subsurface drainage is present, limit 
applications to 12,000 gallons per acre per application.
How SnapPlus identifies this problem: If a fall, spring or summer 
liquid manure application is planned at a rate greater than 12,000 gal-
lon per acre on a field with the “Field in SWQMA” or “Tile Lines Present in 
Field”  boxes checked on the screen, one on these messages will appear.

Red flag: Spring or summer N fertilizer applications 
on this field do not meet the requirements for highly 
permeable soils. Use one of these: split applications, a 
nitrification inhibitor with ammonium forms of N, or a 
slow-release N fertilizer.

590 Standard: On P soils, when commercial N is applied for full 
season crops in the spring and summer, do not exceed the UWEX Pub. 
A2809 crop N rate guidelines and apply one of the following strategies: 
• A split or delayed N application to apply a majority of crop N requirement after crop 

establishment. 
• Use a nitrification inhibitor with ammonium forms of N. 
• Use slow and controlled release fertilizers for a majority of the crop N requirement 

applied near the time of planting.

How to fix the problem: User can split nitrogen applications by 
documenting season applied, summer or spring. Users can also build their 
own nitrogen fertilizer that has an inhibitor or slow-release product. If 
user does build their own fertilizer with inhibitor or slow-release selected 
SnapPlus identifies that and won’t require split application seasons to be 
documented. 

Red flag: Overapplication of N of __ lbs N/acre.

590 Standard: Available N from all sources shall not exceed the annual 
N requirement of non-legume crops consistent with UWEX A2809.
How to fix the problem: User must reduce rate of N applications

Red flag: This field has fall or late-summer N applica-
tions in excess of what is allowed for P soils with a high 
N-leaching potential.

590 Standard: On P and R soils: 
• When a crop is growing, such as perennial crops, overwintering annual crops, 

double crops, and cover crops, use rates that will not smother these crops and limit 
N rates to those specified in UWEX A2809 or 120 pounds per acre of available N, 
whichever is less. 

• For annual crops that will not be planted until the following spring or summer, 
delay application until soil temperatures are less than 50°F or October 1, whichever 
occurs first, and limit N rates to those specified in UWEX Pub. A2809 or 90 pounds 
per acre of available N, whichever is less

How to fix the problem: Reduce fall or late-summer manure appli-
cation so that pounds of available N are less than recommendations in 
A2809 for that specific crop or less than the threshold identified in the 
message (90 or 120 pounds, depending on crop as outlined in the 590 
Standard). If your message indicates that you are using a manure with 
less than 4% dry matter, you will need to follow the additional 590 
restrictions outlined in the message.

continued on next page

Restriction flags	 11
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5 steps for adding pastures 
If you have pastures on your farm, they need to be part of 
the NM plan whether nutrients are applied by grazing or 
gleaning animals or mechanically applied for all seasons 
(see Soil testing and pastures).

4.  Nutrients Screen, add pasture manure source. 
Working in your current crop year, go to the Grazing 
Herd Setup subtab and Add Herd; name the herd and  
select animal group. Next, add animal types and num-
bers to the herd. Remember to hit CALC button each 
time you add another animal type to your herd or 
change any other information in the calculator. This will 
provide a daily rate of manure produced.

Use the Grazing Est button to open the Grazing Appli-
cation Estimator that will determine the manure appli-
cation rate for your pasture. Enter the pasture acreage, 
number of days on pasture and percent of time each day 
spent on pasture. The tons/acre rate is calculated along 
with the animal units (AU). Hit the Refresh button if you 
make changes; make a note of the application rate (a good 
place to keep a record of the rate per acre, days grazing and percent of each 
day is in the Field Notes column for the pasture on the Fields screen).

Go to the Nutrient Sources subtab and add a manure 
source. Select from the dropdown menu the kind of 
grazing manure and type in a name for your manure 
source (use something similar to the herd’s name) and 
save; the manure source will show in the Cropping Tab.

In the upper right hand corner (while still in the Nutrient 
Sources subtab), select the Copy Sources, Fertilizers, 
Herds button. Arrow over your nutrient source and herd 
type and edit dates to cover the time span you wish to 
make the manure available in.   

SnapPlus Tip:  Buttons that open the 
Grazing Est are in all of the places where 
you can enter manure application rate. 

1. Farm Screen, add pastures to your farm’s crops. 
In the Unselected Crops List, select a pasture and stocking 
rate that best describes your pasture/management (see 
Selecting pasture crops for details).  

2a. If you have soil test results, go to the Soil Test 
Screen and import them, then go to SnapMaps, open 
the website, draw the pasture boundaries, download and 
confirm the information on the desktop. Alternatively, you 
can add the pasture on the Field Screen.

2b. If you don’t have soil test results, go to  
SnapMaps, open the website, draw the pasture boundar-
ies, download and confirm the information on the desktop. 
Alternatively, you can add the pasture on the Field Screen. 
Next, go to the Soil Tests Screen and on the bottom half of 
the screen, click the plus sign to add a soil test. Name your 
sample and use the following data:  
reasonable pH level between 5.5-7, 6% organic matter 
(OM), 150 ppm P (set to meet the P Index standard), 101 ppm K. 

3. Cropping Tab, to add crop information to the  
pasture. Navigate to the pasture in the Field dropdown 
menu. In the current year, select pasture as your crop and 
add a yield goal.

Using the Add/Copy/Delete button above the crop years, 
select I want to Add years to end and choose the number 
of years you wish to add.  If this is permanent pasture, you 
may add several years; this will copy all the information you 
entered for your first year.

5. Cropping Tab or Rotation Wizard, add manure 
applications to your pasture.  On the cropping screen, 
go to your pasture and click on any cell in the This 
year’s manure or This year’s fertilizer to open the 
Nutrient Application Planner. Under Manure/Biosolid 
Application, add your grazing herd and the application 
rate (from step 4).

You can also enter the applications using the Rotation 
Wizard>Add crop and application data to fields.

Orange flag: Manure applications (except grazing) are prohibited within 1,000 ft of a municipal well.

590 Standard: Application of untreated manure (except that deposited by grazing animals) is prohibited with 1,000 ft of a public water supply 
designated as a community potable water well.
How this is determined in SnapPlus:  Manures that have been treated to substantially reduce pathogens should be entered on the SnapPlus 
Nutrient Sources tab as the Nutrient Type ‘Treated manure, solid’ or ‘Treated manure, liquid’. If a manure that is not a treated type is applied where 
more than 50% of the field is within the 1,000 ft buffer area of a municipal well, this flag will appear. If less than 50% of the field is within the 
municipal well buffer, a guidance message will be generated indicating that the buffer needs to be avoided.
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Soil testing and pastures
For fields or pastures with mechanical nutrient applica-
tions, determine field nutrient levels from soil samples 
collected within the last 4 years according to 590 Standard 
and UWEX Pub. A2809, Nutrient Application Guidelines for 
Field, Vegetable, and Fruit Crops in Wisconsin, typically  
collecting 1 sample consisting of 10 cores per 5 acres.

Soil tests are not required on pastures that do not receive 
mechanical applications of nutrients if either of the  
following applies:

1. The pasture average stocking rate is one animal unit per 
acre (one AU = 1,000 lbs of animal) or less at all times during 
the grazing season.

2. The pasture is winter grazed or stocked at an average 
stocking rate of more than one animal unit per acre 
during the grazing season, and a nutrient manage-
ment plan for the pasture complies with 590 using an 
assumed soil test phosphorus level of 150 PPM and 
organic matter content of 6%.

A little more advice
When you are finished adding pastures, adjust your 
Rotation Settings to cover the correct span of years in the 
Cropping Tab, then click on Calculate All Years.  

 9  If nothing flags (orange or red), run the  
NM 2 Compliance Check report.

 9  If you have any  flags, they will need to be 
corrected.  You may need to adjust your herd size 
(less animals, shorter time on pasture) improve 
your pasture (more/better cover) get an actual 
slope reading (defaults may be high for your 
slope and slope length) or if you used the default 
setting, take an actual soil test (your actual ppm 
P may be lower than the assumed 150 ppm).   

 9  Remember if you add or reduce animal numbers 
in the future, you will have to go back in your 
plan and modify your animal numbers.

Selecting pasture crops
SnapPlus pastures are identified by the method of  
stocking, animal density and correct pasture plant mix. 
The stocking rates and densities are as follows:

 9 Pasture rotational stocking:  Rotational grazing with 
a maximum of 10 days on before rest, with less than 
2 animal units per acre during grazing season and 
3 inches or greater average minimum grass height. 
There are three choices for this type of pasture: grass/
legume, grass or legume more than 30%.

 9  Pasture, variable stocking, managed continuous:  
This represents a system that may have different 
numbers of animals at different times, but is still 
managed to provide nutrition for the animals and 
maintain 3 inches or greater average minimum grass 
height. Should have less than 2 animal units per acre 
during grazing season. There are three choices for this 
type of pasture: grass/legume, legume more than 30% 
or no crop defined.

 9  Pasture continuous stocking, low density: Animal 
may be present continuously, but the density is so 
low that an average minimum grass height of 3 inches 
is maintained.  No more than 1 animal unit per acre 
planned during grazing season.

 9  Pasture continuous stocking, high density: Animals 
are present continuously or for long periods of time 
at a high enough density that an average minimum 
grass height of 3 inches is not maintained and bare 
areas are present. Greater than 1 animal unit per acre 
continuous stocking can lead to insufficient  
surface cover. 

 9  Pasture, dry lot, exercise area: High animal density. 
Provides <10% nutrition for animals and has many 
bare areas (50%) throughout growing season. Any 
area with 3 or more animal units per acre during the 
growing season should definitely be called a dry lot.

Note: The crop Grass hay should not be used as a pasture crop 
since it does have the sod disturbance expected with grazing. 
Grass hay assumes three cuttings per year of hay with no 
disruption of the soil surface when the hay is cut. Therefore, the 
estimated soil loss from grass hay typically is much less than 
that from any of the pasture crops. Some definitions

Feedlot: A barnyard, exercise area, or other outdoor area where livestock are concentrated for feeding or other purpos-
es and self−sustaining vegetative cover is not maintained. “Feedlot” does not include a winter grazing area or a bare soil 
area such as a cattle lane or a supplemental feeding area located within a pasture, provided that the bare soil area is not 
a significant source of pollution to waters of the state. Note that grazed woodlands are considered feedlots.

Grazing season: Includes the months of the year when pasture vegetation is actively growing.

Pasture:  Land on which livestock graze or otherwise seek feed in a manner that maintains the vegetative cover over the 
grazing area. Pasture may include limited areas of bare soil such as cattle lanes and supplemental feeding areas provided 
the bare soil areas are not significant sources of pollution to waters of the state.
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Getting started in SnapMaps

1 Open a current SnapPlus farm on the desktop.

2 Go to the SnapMaps tab. By default, the SnapMaps 
Fields sub-tab will open.

3 Click the Upload button. This will upload any existing 
field information to the SnapMaps web application. 

4 Click the Website button to work on field maps.  

SnapMaps will open in the web browser.  You will see:

 9 Map Layers panel on the left side of the screen
 9 Menu bar on the top of the screen
 9 Land map on the main part of screen

On the following pages is a complete list of menu items and 
map layers for SnapMaps. This will give you an idea of what 
tools are available and how to use them. 

5 Click the Download button on the desktop SnapMaps 
tab when you have completed your SnapMaps work 
on a farm. This will bring all the field boundaries, fea-
tures, soils, cropped and spreadable acres, and restric-
tions information into the desktop database, where 
they can be imported into the appropriate tabs.  
Important: Click Download whenever you have completed 
map changes you want to keep. Otherwise, you might over-
write the new map information with an upload. 

What if I have shapefiles from another software application?
SnapMaps allows you to import shapefiles from other mapping software for a vari-
ety of features such as fields, wells, manure prohibited areas, exclusion areas, con-
centrated flows, soil sample points and more. Navigate to Drawing Tools > Import a 
Shapefile in SnapMaps online and select the type of feature you are importing. The 
shapefile must be a .zip file for import. Features in SnapMaps can also be exported 
as shapefiles to be used in other GIS software.

Upload with care!
Uploading deletes the cloud data in SnapMaps before 
replacing it with new information from the SnapPlus 
desktop. Because of this, do not upload if you have changes 
made in SnapMaps that have not yet been downloaded. 

Downloading before uploading ensures that you have the 
most recent version of the maps saved in SnapPlus.  
Specific times you need to upload: 

 9 Creating a new farm
 9 Working on a group or subfarm and switching to a 

different one, be sure to download before switching
 9 After adding new fields, merging or splitting fields, or 

changing a field name in the SnapPlus desktop.
 9 Changing plan type between CAFO and 590

Protecting field data from unwanted editing 
There are two ways to protect field data from being overwritten 
when data is downloaded from SnapMaps. 

In the SnapMaps tab, the Locked column: Check this box to 
restrict the importing of data for any given field row. By checking 
this, SnapPlus Import will ignore the downloaded SnapMaps data 
and keep the existing data for that field.
In the Fields tab, the Verified column: Check this box to indicate 
that the information in that row has been verified by the county 
LCD and that you do not want it to change upon future SnapMap 
imports. 
This is useful when you import new information into SnapPlus 
but do not want the values of a certain field to be overwritten 
by that information. If at some later date you want to re-enable 
overwriting, just uncheck the Verified box and the import will 
proceed as usual. 

Important note!  When the verified box is checked on the Fields 
tab, the locked button on the SnapMaps tab is automatically 
checked. If you want to import from SnapMaps, you will also 
need to go to the SnapMaps tab and uncheck the Is Locked box 
so you can import into the Fields tab successfully!

SnapPlus Tip: Need something explained? 
Click the Help in the far right upper corner 
of the SnapMaps website! 

SnapPlus Tip: After you have 
downloaded from SnapMaps, don’t 
forget to click the Import Highlighted 
Cells button to add the new data.

Field, cropped and manure 
spreadable acres
In addition to calculating the total number of acres in a field, 
SnapMaps calculates how much of the field can be cropped 
(Cropping acres), meets the requirements for manure spreading 
(Manure spreadable acres), and where frozen and snow-covered 
soil manure spreading is allowed (Winter spreadable).  These 
acres are displayed and editable in the Spreadable Acres table 
accessible from the Fields tab.  

How can I make maps with better titles and  smaller legends  
with only what is relevant? 
Open a Word or PowerPoint file. Add your title. Use the Microsoft Snipping Tool 
to make a picture of anything you see on your computer or SnapMaps screen and 
paste it into the open Word or PowerPoint file. To get the Snipping Tool, click the 
Microsoft Start Flag and type the tool name in the search box. Make one legend and 
get multiple fields on one page regardless of their proximity to each other.

 
590 restrictions:  Nutrient application restrictions from 
the 590 standard, which include winter spreading, surface 
water quality management area (SWQMA), fall nitrogen 
application, set-backs from conduits to groundwater, and 
other restrictions. 

Adjusted UW recommendations:  P2O5 & K2O 
recommended by University of Wisconsin for that crop  
and soil test minus the P2O5 & K2O carryover since the  
last soil test.

CAFO manure restriction (R) or(W): Soils that are 
typically less than 24 inches to bedrock (R) or apparent 
water table (W).

Concentrated flow channel: Areas within or on field  
edges where water flow channelizes and can erode soil.

Conduits to groundwater: Wells, sinkholes and other 
landscape features that can provide a direct connection  
for water to flow from the soil surface to the ground- 
water table.

Cropping year:  For a field, the new cropping year starts 
after the previous crop has been harvested and spans the 
time to the next harvest. 

Drained: Indicates the field is artificially drained with 
drainage ditches or sub-surface tiles. Checking this will 
remove the limitation on crop production for poorly 
drained and very poorly drained silt loam soils. If a soil 
has no other limitations, checking drained will change 
a soil from medium to high yield potential for corn N 
recommendations. 

Ephemeral channel: A shallow channel caused by the 
convergence of overland sheet flow and rill erosion. It will 
reoccur in the same place after the field is tilled.

Field “T”:  Tolerable soil loss (the amount the field can lose 
in tons/acre/year) as determined by soil type.

Filter areas:   A grass strip within a field or an area on 
the edge of a field designed to capture sediment in 
runoff. These selections in SnapPlus assume there are no 
concentrated flow channels through the grass filters.

Gully: An erosion channel that cannot be crossed with 
ordinary farming equipment.

Locked: When is Locked is checked for a field in the 
SnapMap Fields tab, new SnapMaps field information for 
that field will not import into SnapPlus and over-write 
existing data.

Municipal well: A public water system identified by the 
Wisconsin Department of Natural Resources (WI DNR) as a 
community potable well. Can be owned by a municipality 
or by an entity such as a mobile home park or subdivision. 
These points are already included in SnapMaps.

N restricted soil:   Soils that have the potential for nitrate 
leaching to ground water. Definition of symbols:  
(P) High permeability soils, (R) Less than 20 inches to 
bedrock, (W) Less than 12 inches to apparent water table, 
(+) This map unit may have any of the N restrictive features, 
however an on-site investigation is needed to identify 
which restrictions may actually be present.

On-contour:  A field that is consistently planted and tilled 
on the contour across the slope.

P Index:  The Wisconsin Phosphorus Index, a planning tool 
used to rank fields by runoff P loss potential. Annual total 
PI is calculated by estimating the average annual runoff P 
delivery from a field to surface water. Particulate PI is an 
estimate of P delivered with eroded sediment, and Soluble 
PI is an estimate of dissolved P delivered from soil and 
nutrient applications.

Public well: A well that serves at least 25 of the same 
people over 6 months of the year.  These wells are identified 
as non-community potable wells by the WI DNR and include 
schools, restaurants and churches. Planners need to add 
these as points to their maps.

Spread method:  Unincorporated (broadcast on surface 
with more than 72 hours before tillage); Incorporated 
(surface-applied and incorporated into soil by tillage or 
infiltration); Injected-manure (injected below soil surface or 
incorporated by tillage within 1 hour); SubSurface-fertilizer 
(applied below the soil surface); Grazing-manure (deposited 
directly from the animal).

Soil conditioning Index (SCI): A positive number indicates 
soil organic matter is likely increasing across the rotation, 
while a negative number indicates it is likely to be  
decreasing.

Strip crop: Contour strips of alternating row and hay crops. 
Assumes at least two strips on the field slope length. This is 
more restrictive and helps reduce calculated erosion more 
than on-contour.

Tiled: Indicates subsurface drainage is present in the field 
and liquid manure rates are limited to 12,000 gallon per 
acre per application. 

SWQMA: A Surface Water Quality Management Area is an 
area within 300 ft of a perennial stream/river or 1,000 ft of  
a lake/pond.

Verified:  Checking verified in the Fields tab or in the 
Spreadable Acres table says that the field information has 
been updated through field observations by a county LCD. 
This check will prevent future SnapMaps imports from 
overwriting the verified information.

Winter strategies: Winter strategies are conservation 
practices listed in the 590 standard that are applicable 
when winter manure applications are planned on fields 
with slopes greater than 6% and/or concentrated flow 
channels present in or on the field boundary. A minimum  
of two winter strategies must be in place for these fields.
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SnapMaps	 15

Getting started in SnapMaps

1 Open a current SnapPlus farm on the desktop.

2 Go to the SnapMaps tab. By default, the SnapMaps 
Fields sub-tab will open.

3 Click the Upload button. This will upload any existing 
field information to the SnapMaps web application. 

4 Click the Website button to work on field maps.  

SnapMaps will open in the web browser.  You will see:

 9 Map Layers panel on the left side of the screen
 9 Menu bar on the top of the screen
 9 Land map on the main part of screen

On the following pages is a complete list of menu items and 
map layers for SnapMaps. This will give you an idea of what 
tools are available and how to use them. 

5 Click the Download button on the desktop SnapMaps 
tab when you have completed your SnapMaps work 
on a farm. This will bring all the field boundaries, fea-
tures, soils, cropped and spreadable acres, and restric-
tions information into the desktop database, where 
they can be imported into the appropriate tabs.  
Important: Click Download whenever you have completed 
map changes you want to keep. Otherwise, you might over-
write the new map information with an upload. 

What if I have shapefiles from another software application?
SnapMaps allows you to import shapefiles from other mapping software for a vari-
ety of features such as fields, wells, manure prohibited areas, exclusion areas, con-
centrated flows, soil sample points and more. Navigate to Drawing Tools > Import a 
Shapefile in SnapMaps online and select the type of feature you are importing. The 
shapefile must be a .zip file for import. Features in SnapMaps can also be exported 
as shapefiles to be used in other GIS software.

Upload with care!
Uploading deletes the cloud data in SnapMaps before 
replacing it with new information from the SnapPlus 
desktop. Because of this, do not upload if you have changes 
made in SnapMaps that have not yet been downloaded. 

Downloading before uploading ensures that you have the 
most recent version of the maps saved in SnapPlus.  
Specific times you need to upload: 

 9 Creating a new farm
 9 Working on a group or subfarm and switching to a 

different one, be sure to download before switching
 9 After adding new fields, merging or splitting fields, or 

changing a field name in the SnapPlus desktop.
 9 Changing plan type between CAFO and 590

Protecting field data from unwanted editing 
There are two ways to protect field data from being overwritten 
when data is downloaded from SnapMaps. 

In the SnapMaps tab, the Locked column: Check this box to 
restrict the importing of data for any given field row. By checking 
this, SnapPlus Import will ignore the downloaded SnapMaps data 
and keep the existing data for that field.
In the Fields tab, the Verified column: Check this box to indicate 
that the information in that row has been verified by the county 
LCD and that you do not want it to change upon future SnapMap 
imports. 
This is useful when you import new information into SnapPlus 
but do not want the values of a certain field to be overwritten 
by that information. If at some later date you want to re-enable 
overwriting, just uncheck the Verified box and the import will 
proceed as usual. 

Important note!  When the verified box is checked on the Fields 
tab, the locked button on the SnapMaps tab is automatically 
checked. If you want to import from SnapMaps, you will also 
need to go to the SnapMaps tab and uncheck the Is Locked box 
so you can import into the Fields tab successfully!

SnapPlus Tip: Need something explained? 
Click the Help in the far right upper corner 
of the SnapMaps website! 

SnapPlus Tip: After you have 
downloaded from SnapMaps, don’t 
forget to click the Import Highlighted 
Cells button to add the new data.

Field, cropped and manure 
spreadable acres
In addition to calculating the total number of acres in a field, 
SnapMaps calculates how much of the field can be cropped 
(Cropping acres), meets the requirements for manure spreading 
(Manure spreadable acres), and where frozen and snow-covered 
soil manure spreading is allowed (Winter spreadable).  These 
acres are displayed and editable in the Spreadable Acres table 
accessible from the Fields tab.  

How can I make maps with better titles and  smaller legends  
with only what is relevant? 
Open a Word or PowerPoint file. Add your title. Use the Microsoft Snipping Tool 
to make a picture of anything you see on your computer or SnapMaps screen and 
paste it into the open Word or PowerPoint file. To get the Snipping Tool, click the 
Microsoft Start Flag and type the tool name in the search box. Make one legend and 
get multiple fields on one page regardless of their proximity to each other.
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Where can I find nutrient management 
planning characteristics of the all the 
soil series mapped in Wisconsin?

On the SnapPlus website under PLANNING 
INFO>SOILS DETAILS is a link to a filterable 
spreadsheet called Wisconsin Soil Classifications 
for Nutrient Management Planning. There are also 
links to spreadsheets showing which soil map unit 
characteristics used in SnapPlus were updated in 
past NRCS Soil Survey updates.

SnapMaps desktop TABS

SnapMap Fields

Displays information about each field from SnapMaps.  
SnapMaps calculates the area of the field in acres, the 
soil map symbols for the critical and dominant soils, and 
the average slope and the distance from the middle of 
the field to the nearest surface water (used for P Index 
calculations).  The displayed slope and slope length are 
the defaults for the Critical soil.  Use the Import button 
at the bottom left of the tab to import *highlighted* field 
information to the SnapPlus Fields page. 

Restrictions

Displays the nutrient application restriction areas for each 
field from SnapMaps. Use the Import button at the bottom 
left of the tab to to import *highlighted* restrictions to the 
SnapPlus Field Restriction Features

SnapMap Acres

For a non-permitted farm, the tab displays five Snap-
Maps-calculated acre columns for each field: Actual Field 
Boundary Acres (total acres inside boundaries), Farmed/
cropping (cropped acres = total acres - exclusions),  
Manure spreadable, Manure prohibited and  
Winter spreadable acres. 

For a permitted farm (CAFO), the tab displays two ver-
sions of the Manure spreadable and Manure prohibited 
acres. One is for when a 25 ft no-manure area is required 
along waterways (allowed when manure is injected or 
incorporated or in long-term no-till) and the other is for 
when a 100 ft no-manure buffer is needed (most surface 
applications). 

SnapMap Soils

Displays information about the individual soils that 
make up each field. This SnapMaps subtab lists the 
symbols for all the soil map units found on each field in 
the plan and the percentage of the field covered. 

A soil map unit symbol begins with letters or numbers 
that stand for the soil series name and is followed by 
a capital letter that stands for the slope class (plus a 
number 2 if the soil is eroded): A = 1-2%. B = 2-6%, C= 
6-12%, and D =12-18% slope. For example, DgD2 is a 
Dodgeville silt loam with slopes between 12 – 18%.    If 
there is no capital letter at the end of the symbol, the 
soil is very flat.  

This table also shows soil map unit characteristics used 
in SnapPlus calculations: the default (typical) slope 
and slope length for that soil map unit, the Soil group 
(Loamy, Organic, Sandy), Yield potential (for corn N 
response (High, Medium, Sandy), the soil erodibility 
factor K, Tolerable soil loss value T, Erosion Sensitivity 
ES (calculated using soil, slope length, K and T), and 
late summer-fall N restrictions classifications based on 
soil characteristics (Shallow water table W, Shallow to 
Bedrock R, and Highly Permeable P).

SnapMap Features

Lists all of the user-drawn features specified in Snap-
Maps along with the geometry.

? What are critical and predominant soils?
There may be many soil map units with widely 
ranging characteristics mapped in a single field. 

SnapMaps is designed to select the ones best suited 
for use in erosion calculation and fertility recommen-
dations.

Critical soil: This is the soil map unit used in the soil 
loss calculations in SnapPlus. It is automatically filled 
with the most vulnerable soil (highest Erosion Sensi-
tivity) that makes up at least 10% of a field. 

Predominant soil: This is the soil map unit that is 
used for making crop nutrient recommendations. It is 
automatically filled in with the soil map unit that cov-
ers most of the field. If there is no map unit that makes 
up more than 50% of the field, SnapPlus selects a map 
unit with a Soil group and Yield Potential that best 
represents the field.
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SnapMaps website TABS

On the left side of the screen is a collapsible window with 
the three tabs:  Map Legend, Field Properties and Field 
List.  By default, the window is open with the Map Legend 
tab selected.  Each tab provides a wealth of information 
about, and in some cases, opportunities for customizing 
fields that you have drawn or imported into SnapMaps or 
entered in from the SnapPlus desktop application.

Above the tabs is some information: Layers, Farm Name 
and View Metadata. Clicking the Layers button will col-
lapse the window vertically and clicking on View Metadata 
will create a Microsoft Excel file (download) that contains 
background information on the active layers, including the 
source, the year it is from and a short description.

Map Legend

Field Properties
The Field Properties tab allows you to code your Snap-
Maps using the Farm Variables subtab or customize the 
field labels using the Field Labels subtab. To collapse or 
expand the subtabs, just click on their names. Note that 
the cropping year is set to the year that you are currently 
working in the SnapPlus desktop application.

The Farm Variables subtab offers the following variables 
available in the dropdown menu; use the Create a PDF 
variable map button to download and print the map.

Is irrigated
Too few soil samples
Soil test too old
N:  Over (+)/Under(-) adj UW rec
P2O5:  Over (+)/Under(-) adj UW rec
K2O:  Over (+)/Under(-) adj UW rec
Expected spring residue cover
Soil test P
Soil test K
Soil pH

The Field Labels subtab allows you to select one or two  
variables from dropdown menus to create customized 
field labels for your SnapMaps.

Rotational soil conditioning index
Rotation avg P Index
Organic Matter %
Rotation avg soil loss
Lime (NI 60-69) need
Adjusted P2O5 need
Adjusted K2O need
Soil loss compared to tolerance
Rotational P2O5 Balance
Rotational K2O Balance
On contour

SnapMap Field Name
SnapMap Field Acres
Field Acres 
Spreadable acres 25 ft strategy
Spreadable acres 100 ft strategy
Winter Spreadable acres
Tract ID
FSA Field name
Crop

Lime (NI 60-69) need
Adjusted P2O5 need
Adjusted K2O need
Rotation avg soil loss
Soil loss compared to 
tolerance
Soil test P ppm
Soil test K ppm
Organic matter %

Field List 
The Field List tab displays a list of all current fields entered 
in SnapMaps in a table format with the following columns: 
Field Name, Acres, Crops, Tillage and Applications.  When 
you type text into the search text box, fields will be 
filtered based on the text you type in. For example, if you 
type in corn, all fields that have corn will be filtered and 
shown. This also will filter the map and only fields that 
meet the search criteria will be displayed.

From this tab, you can export the table into a .CSV file, a 
Microsoft Excel file or a PDF.  You can also print directly 
and search the table from within the tab.

Create custom Field Property maps
Visualize key information about your fields! 
For example, you can display field soil test P values, expected spring residue cover,  
N: Over/under values & more.

To make a Field Property Map, click the Field Properties 
tab. Select a Field Variable you would like to map from 
the drop-down menu. Pan and zoom to your desired fields, 
then click Create PDF Variable Map to download a copy. 

Customize field labels by expanding the Field Labels panel 
and select new label variables from the dropdown menus.  

See the following page for 
description.



18

Understanding the layers and their meanings (non-permitted farms)
Below are what you would see for a non-permitted farm; CAFOs will have a few extra layers with special nutrient  
management planning requirements. 

SnapMaps layers contain information using colors, patterns and symbols that can be turned on/off with multiple layers 
active at any one time (layers are stacked on top of each other in a set order — the first active layer in the list will be drawn 
on the bottom, then the next one on the list drawn on top of it, and so on; layer transparency can be set with the slider). 
Many of the layers are semi-transparent so that they may be used together. If you want to turn on all of the layers in a sec-

tion, check the Turn on/off all checkbox next to the layer title. To turn them all off, 
uncheck the box. You may have to click this twice to get the result you desire. 

Map Legend

Water Layers

Silurian Layers

Reference layers  These layers are not currently 
required for 590 nutrient management plans. 

Atrazine Layers

Historic Mine  
Features

Use the slider 
to reduce or 
increase the 
transparency 
of the layer

Turn a layer on or off 
by checking the box

The farm layers displays 
some of the features that 
you draw in SnapMaps, 
such as field boundaries, 
exclusion areas, point 
features (like wells and 
sinkholes) and tile lines.

County defined karst 
features are already 
included in the SnapMap 
layer.  They can be  
turned on/off by  
checking the box.

Winter Spreading and 
Winter Manure  

Prohibited Area Layers 

Base Layers

Restriction Layers

Farm Layers
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SnapMaps website MENU
Across the top of the screen is the menu bar. Click on the 
dropdown menus to see the list of options for each

Information Tools Menu
 9 Clear Active Tool
 9 Uncheck All Layers Except Area
 9 Identify Soil Type
 9 Identify Field
 9 Create Text File of Parcels for Farm
 9 Measure Distance
 9 Measure Area
 9 Spreadable Acres (update)
 9 Change Shapefile Export Projection (for exporting shapefiles)

Drawing Tools Menu
Draw Features
 9Field 
 9Field with Common Land Unit
 9Exclusion Area
 9Concentrated Flow Channel
 9Point 
 9Tile Line
 9Soil Sample
 9Annotation
 9Headland Stack
 9Manure Prohibited Area
 9Manure prohibited area by buffering field boundary
 9Manure prohibited area by buffering water features in a field
 9Manure prohibited area by buffering wetland features in a field
 9Manure prohibited area by buffering custom features

Edit Features
 9Fields
 9Fields with Common Boundary
 9Points
 9Exclusion Areas
 9Soil Sample
 9Annotation
 9Manure Prohibited Area
 9Split Manure Prohibited Areas
 9Concentrated Flow Channels
 9Split Fields
 9Dismiss a 1000 ft SWQMA
 9Restore Dismissed 1000 ft SWQMA
 9Headland Stack

Delete Features
 9Fields
 9Points
 9Exclusion Areas
 9Concentrated Flow Channels
 9Tile Lines
 9Soil Samples
 9Annotation
 9Manure Prohibited Area
 9Delete Geometry for Updating Boundaries
 9Headland Stack 

Field Snapping (drawing snaps to field boundaries)

Import a Shapefile (zipfile (must contain a shapefile)

 9Fields
 9Points
 9Exclusions
 9Concentrated Flow Channels
 9Tile Lines
 9Soil Samples
 9Manure Prohibited Areas
 9Headland Stacks 

Export to Shapefile (zipfile (must contain a shapefile)

 9Fields
 9Points
 9Exclusions
 9Tile Lines
 9Concentrated Flow Channels
 9Soil Samples
 9Manure Prohibited Areas
 9Headland Stacks 
 9All Features
 9Spreadable Field Acres
 95-acre Polygons Created from Fields
 91-acre Centroids Created from Fields
 9Manure Applications
 9Winter Spreadable Field Areas

PDF Creation Menu
 9Create PDF of Map
 9Create PDF of Winter Manure Prohibited Areas Map
 9Load a Saved Print Map Area
 9Define Print Map Area
 9Clear Print Map Areas
 9Create Map Legend Description

Search T-R-S

About

Help

The Drawing Tools 
Menu contains six 
sub-levels with 
multiple tools for 
each!
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Gold lines or squares:   
Nitrogen (N) restricted soils
Soils identified as having a high risk for allowing contami-
nates to leach through to groundwater are labeled  
P (high permeability), R (bedrock likely to be within 20 
inches of the soil surface), or W (water table within 12 
inches of the surface). These soils have restrictions on the 
rates of fertilizer and manure N applied in the late sum-
mer or fall. In addition, P soils require practices to prevent 
N fertilizer leaching year-round.

Blue diagonal line pattern:   
SWQMAs
What is a SWQMA?  SWQMA stands for Surface Water 
Quality Management Area.  They require special care 
in management to avoid surface water contamination 
because they are adjacent to surface water. Specific 
conservation practices must be in place for fall, spring and 
summer nutrient applications. No nutrient applications 
are allowed in the winter. The SWQMA for streams and 
rivers is 300 ft on each side, while that for lakes and ponds 
extends for 1000 ft.   Note: SWQMA is often pronounced as swik-muh.

Orange areas:  
Bedrock depth less than 5 ft
Why does bedrock depth matter?  Those areas where 
bedrock is within 5 feet of the surface are deemed to have 
an increased risk of groundwater contamination and have 
some restrictions on fertilizer nitrogen applications in the 
fall and late summer when no crop is being grown.

Red areas:  
Nutrient prohibited areas
Red areas on the maps show where there is a prohibition 
on manure applications. These are often buffer areas 
around direct conduits to groundwater, such as wells and 
sinkholes. The exact prohibitions for these areas vary by 
the feature they buffer, and in some cases, fertilizer is  
also prohibited.

For example, there is a 1000 ft no-manure area around mu-
nicipal wells to protect public water supplies — manure 
can be applied if it has been treated to kill pathogens.

Restriction Layers

Planners can also draw manure prohibited areas to show where manure is prohibited 
in a particular area of a field or the boundary around a field at a custom width.



21

Khaki diagonal line pattern: 
Direct conduit to GW 300 ft
Direct conduits to groundwater have a 300 ft setback for 
winter manure applications. The setback surrounds direct 
conduits including wells, sinkholes, fractured bedrock at 
the surface, mine shafts, non-metallic mines, tile inlets 
discharging to groundwater, quarries or depressional 
groundwater recharge areas over shallow fractured  
bedrock. 

Pink areas:  
Winter restrictions slope > 6%
The areas in pink are likely to have slopes greater than 6%.  
Winter manure applications on fields with slopes greater 
than 6% require special management to protect against 
manure runoff.

When is winter? Winter conditions are defined as having 
frozen or snow-covered soils that prevent effective 
incorporation at the time of application.  

Yellow diagonal line pattern:  
Silurian soils
Why are these soils important?  The areas designated as 
Silurian soils are likely to have less than 5 feet of soil over 
Silurian dolomite bedrock. This type of dolomite bedrock 
has numerous cracks and fractures that can allow water 
to flow rapidly from the soil to groundwater. To protect 
groundwater from contamination, manure applications 
are prohibited in February and March.

Red diagonal line pattern:  
Well compensation
These are areas where wells have been contaminated 
with livestock manure in the past.  To protect from future 
contamination, manure applications are prohibited in  
February and March.

Winter Spreading and Prohibition Area Layers for non-permitted farms
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White lines:  
Field boundariesField boundaries
Field boundaries can be either drawn in SnapMaps or  
imported as shapefiles from other mapping programs. 
In the Field Properties tab, you can customize the field 
label to include data such as field acres, spreadable acres 
strategy, winter spreadable acres, tract ID, FSA name, crop, 
rotation average soil loss, soil test P, K or pH, and  
organic matter.

Crosshatched areas, multiple colors:  
Exclusion areas
Exclusion areas are drawn in SnapMaps and represent the 
part(s) of a field that should not be included in the field 
acres for nutrient management planning. Exclusion areas 
include the following:

Yellow = Not farmed      Magenta = Grass filter area 
Green = Vegetated buffer   Blue = Non-metallic mine 
Black = Sinkhole/   Purple = Other 
other karst feature Solid blue = Waterbody

Icons or symbols:  
Point features
Point features include wells, irrigation wells, drinking 
wells, fractured bedrock, sinkholes, non-metallic mines, 
other direct conduits to groundwater, tile inlets and 
outlets. Once drawn, SnapMaps automatically creates 
the appropriate nutrient prohibition buffer (a red circle) 
around all point features that would provide a pathway 
for groundwater contamination. 

Farm Layers 

Red lines:  
Tile lines
Tile drainage removes excess water from soil below the 
surface, so it is important to document where tile lines 
and outlets are located. In SnapPlus, you can create mul-
tiple tile lines in one edit session. Don’t forget to add the 
tile inlets (if known) and outlets as point features (they 
will display as orange arrows).  
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Light green  areas:   
DNR wetland
A wetland is an area where water is at, near or above the 
land surface long enough to be capable of supporting 
aquatic or hydrophytic vegetation and which has soils 
indicative of wet conditions.  There are required setbacks 
from wetlands for permitted farms (CAFOs).

Blue lines:   
Perennial or intermittent streams
Perennial streams are indicated with a solid blue line  
and may or may not be named on the map. Intermittent 
streams are a dashed blue line. Normally, a perennial 
stream has water in its channel at all times, while an 
intermittent stream flows only when it receives water 
from rainfall runoff or from some surface source (such as 
melting snow).

Water Layers

Colored lines, varying widths:  
Concentrated flow channels
Planners need to draw recognizable flow channels in a field 
or adjacent to fields. Flow channels can be drawn with vary-
ing widths from 5-100 feet. Areas with concentrated flow 
channels need special management for winter manure 
applications to avoid manure runoff. Ephemeral erosion 
channels and eroding gullies need to be remediated.

Turquoise = Ephemeral erosion channel  
Orange = Grassed waterway   Red = Non-eroding channel 
Brown = Ditch Magenta = Gully 

Blue areas:  
Waterbodies
Lakes and ponds are considered perennial waterbodies 
that hold water year-round. They are Surface Water  
Quality Management Areas (SWQMAs) that require  
special care in management to avoid surface water  
contamination from runoff or soil erosion.
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 Wisconsin Department of Agriculture, Trade and Consumer Protection 
Division of Agricultural Resource Management 
Bureau of Land and Water Resources 
PO Box 8911, Madison WI  53708-8911, Phone: 608-224-4605 

Nutrient Management Checklist Wis. Stat. §92.05(3) (k), Wis. Admin. Code §ATCP50.04(3) and Ch. 51 

 COUNTY       DATE PLAN SUBMITTED       GROWING SEASON YEAR PLAN IS WRITTEN FOR        (from harvest to harvest)  

TOWNSHIP: (T.       N.) RANGE: (R.       E., W). CHECK ONE: Initial Plan or  Updated Plan 

NAME OF FARM OPERATOR RECEIVING NM PLAN 
First Name  LastName 

FARM NAME (OPTIONAL)   
      

BUSINESS PHONE  
(   )     -      

STREET ADDRESS  
      

CITY 
      

STATE 
   

ZIP 
      

REASON THE PLAN WAS DEVELOPED:  Click and choose.  
(Ordinance, NR 243 WPDES or NOD, DATCP-FP or cost share (cs), DNR-cs, USDA-cs, Other) 

CROPLAND ACRES (OWNED & RENTED)  
      

RENTED FARM(S) LANDOWNER NAME(S) AND ACREAGE: add sheet(s) if needed 
      

WAS THE PLAN WRITTEN IN SNAPPLUS?  YES  N0 If yes, which software version, if known?        
CHECK PLANNER’S QUALIFICATION: Click and choose.  
(1. NAICC-CPCC, 2. ASA-CCA, 3. SSSA-Soil Scientist, 4. DATCP approved training course, 5. Other approved by DATCP)  

NAME OF QUALIFIED NUTRIENT MANAGEMENT PLANNER 
First Name Last Name 

BUSINESS PHONE  
(   )     -      

STREET ADDRESS  
      

CITY 
      

STATE 
   

ZIP 
      

Use header sections to add comments.  Mark NA in the shaded sections if no manure is applied. 
1.  Does the plan include the following nutrient application requirements to protect surface and groundwater?    
      
This section applies to fields and pastures.  If no manure is applied, check NA for 1.c., 1.h., 1.i., 1.n., 1.o., 1.q., 1.s.  Yes No NA 
a. Determine field nutrient levels from soil samples analyzed by a DATCP certified laboratory.  ☐ ☐ ☐ 
b. For fields or pastures with mechanical nutrient applications, determine field nutrient levels from soil samples collected 

within the last 4 years according to 590 Standard (590) and UWEX Pub. A2809, Nutrient Application Guidelines for Field, 
Vegetable, and Fruit Crops in Wisconsin (A2809) typically collecting 1 sample per 5 acres of 10 cores.  Soil tests are not 
required on pastures that do not receive mechanical applications of nutrients if either of the following applies:   

    1.  The pasture average stocking rate is one animal unit per acre or less at all times during the grazing season.   
    2.  The pasture is winter grazed or stocked at an average stocking rate of more than one animal unit per acre during the 

grazing season, and a nutrient management plan for the pasture complies with 590 using an assumed soil test 
phosphorus level of 150 PPM and organic matter content of 6%. 

☐ ☐ ☐ 

c. For livestock siting permit approval, collect and analyze soil samples meeting the requirements above in 1. b., 
excluding pastures, within 12 months of approval and revise the nutrient management plan accordingly.  Until then, 
either option below maybe used:   

    1. Assume soil test phosphorus levels are greater than 100 ppm soil test P,  OR  
    2. Use preliminary estimates analyzed by a certified DATCP laboratory with soil samples representing > 5 ac/sample. 

☐ ☐ ☐ 

d. Identify all fields’ name, boundary, acres, and location. ☐ ☐ ☐ 
e. Use the field’s previous year’s legume credit and/or applications, predominant soil series, and realistic yield goals to 

determine the crop’s nutrient application rates consistent with A2809 for ALL forms of N, P, and K. ☐ ☐ ☐ 

f. Make no winter applications of N and P fertilizer, except on grass pastures and winter grains. ☐ ☐ ☐ 
g. Document method used to determine application rates. Nutrients shall not runoff during or immediately after 

application. ☐ ☐ ☐ 

h. Identify in the plan that adequate acreage is available for manure produced and/or applied. ☐ ☐ ☐ 
i. Apply a single phosphorus (P) assessment using either the P Index or soil test P management strategy to all fields within 

a tract when fields receive manure or organic by-products during the crop rotation.  ☐ ☐ ☐ 

j. Use complete crop rotations and the field’s critical soil series to determine that sheet and rill erosion estimates will not 
exceed tolerable soil loss (T) rates on fields that receive nutrients. ☐ ☐ ☐ 

k. Use contours; reduce tillage; adjust the crop rotation; or implement other practices to prevent ephemeral erosion; and 
maintain perennial vegetative cover to prevent reoccurring gullies in areas of concentrated flow.   ☐ ☐ ☐ 

l.  Make no nutrient applications within 8’ of irrigation wells or where vegetation is not removed. ☐ ☐ ☐ 
m. Make no nutrient applications within 50’ of all direct conduits to groundwater, unless directly deposited by 

gleaning/pasturing animals or applied as starter fertilizer to corn.   ☐ ☐ ☐ 

  

Use this form to check nutrient management (NM) plans 
for compliance with the WI NRCS 2015-590 Standard. 

NM checklist and tips	 24
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 Wisconsin Department of Agriculture, Trade and Consumer Protection 
Division of Agricultural Resource Management 
Bureau of Land and Water Resources 
PO Box 8911, Madison WI  53708-8911, Phone: 608-224-4605 

Nutrient Management Checklist Wis. Stat. §92.05(3) (k), Wis. Admin. Code §ATCP50.04(3) and Ch. 51 

 COUNTY       DATE PLAN SUBMITTED       GROWING SEASON YEAR PLAN IS WRITTEN FOR        (from harvest to harvest)  

TOWNSHIP: (T.       N.) RANGE: (R.       E., W). CHECK ONE: Initial Plan or  Updated Plan 

NAME OF FARM OPERATOR RECEIVING NM PLAN 
First Name  LastName 

FARM NAME (OPTIONAL)   
      

BUSINESS PHONE  
(   )     -      

STREET ADDRESS  
      

CITY 
      

STATE 
   

ZIP 
      

REASON THE PLAN WAS DEVELOPED:  Click and choose.  
(Ordinance, NR 243 WPDES or NOD, DATCP-FP or cost share (cs), DNR-cs, USDA-cs, Other) 

CROPLAND ACRES (OWNED & RENTED)  
      

RENTED FARM(S) LANDOWNER NAME(S) AND ACREAGE: add sheet(s) if needed 
      

WAS THE PLAN WRITTEN IN SNAPPLUS?  YES  N0 If yes, which software version, if known?        
CHECK PLANNER’S QUALIFICATION: Click and choose.  
(1. NAICC-CPCC, 2. ASA-CCA, 3. SSSA-Soil Scientist, 4. DATCP approved training course, 5. Other approved by DATCP)  

NAME OF QUALIFIED NUTRIENT MANAGEMENT PLANNER 
First Name Last Name 

BUSINESS PHONE  
(   )     -      

STREET ADDRESS  
      

CITY 
      

STATE 
   

ZIP 
      

Use header sections to add comments.  Mark NA in the shaded sections if no manure is applied. 
1.  Does the plan include the following nutrient application requirements to protect surface and groundwater?    
      
This section applies to fields and pastures.  If no manure is applied, check NA for 1.c., 1.h., 1.i., 1.n., 1.o., 1.q., 1.s.  Yes No NA 
a. Determine field nutrient levels from soil samples analyzed by a DATCP certified laboratory.  ☐ ☐ ☐ 
b. For fields or pastures with mechanical nutrient applications, determine field nutrient levels from soil samples collected 

within the last 4 years according to 590 Standard (590) and UWEX Pub. A2809, Nutrient Application Guidelines for Field, 
Vegetable, and Fruit Crops in Wisconsin (A2809) typically collecting 1 sample per 5 acres of 10 cores.  Soil tests are not 
required on pastures that do not receive mechanical applications of nutrients if either of the following applies:   

    1.  The pasture average stocking rate is one animal unit per acre or less at all times during the grazing season.   
    2.  The pasture is winter grazed or stocked at an average stocking rate of more than one animal unit per acre during the 

grazing season, and a nutrient management plan for the pasture complies with 590 using an assumed soil test 
phosphorus level of 150 PPM and organic matter content of 6%. 

☐ ☐ ☐ 

c. For livestock siting permit approval, collect and analyze soil samples meeting the requirements above in 1. b., 
excluding pastures, within 12 months of approval and revise the nutrient management plan accordingly.  Until then, 
either option below maybe used:   

    1. Assume soil test phosphorus levels are greater than 100 ppm soil test P,  OR  
    2. Use preliminary estimates analyzed by a certified DATCP laboratory with soil samples representing > 5 ac/sample. 

☐ ☐ ☐ 

d. Identify all fields’ name, boundary, acres, and location. ☐ ☐ ☐ 
e. Use the field’s previous year’s legume credit and/or applications, predominant soil series, and realistic yield goals to 

determine the crop’s nutrient application rates consistent with A2809 for ALL forms of N, P, and K. ☐ ☐ ☐ 

f. Make no winter applications of N and P fertilizer, except on grass pastures and winter grains. ☐ ☐ ☐ 
g. Document method used to determine application rates. Nutrients shall not runoff during or immediately after 

application. ☐ ☐ ☐ 

h. Identify in the plan that adequate acreage is available for manure produced and/or applied. ☐ ☐ ☐ 
i. Apply a single phosphorus (P) assessment using either the P Index or soil test P management strategy to all fields within 

a tract when fields receive manure or organic by-products during the crop rotation.  ☐ ☐ ☐ 

j. Use complete crop rotations and the field’s critical soil series to determine that sheet and rill erosion estimates will not 
exceed tolerable soil loss (T) rates on fields that receive nutrients. ☐ ☐ ☐ 

k. Use contours; reduce tillage; adjust the crop rotation; or implement other practices to prevent ephemeral erosion; and 
maintain perennial vegetative cover to prevent reoccurring gullies in areas of concentrated flow.   ☐ ☐ ☐ 

l.  Make no nutrient applications within 8’ of irrigation wells or where vegetation is not removed. ☐ ☐ ☐ 
m. Make no nutrient applications within 50’ of all direct conduits to groundwater, unless directly deposited by 

gleaning/pasturing animals or applied as starter fertilizer to corn.   ☐ ☐ ☐ 

  

Use this form to check nutrient management (NM) plans 
for compliance with the WI NRCS 2015-590 Standard. 

SnapPlus checks yes if soil test results are present for every active field.

SnapPlus will check NA for all shaded areas if  
no manure or organic wastes are  
applied in plan (1 c,h,i,n,q,s and 2 a-g).

Add comments and explanations for the plan in this section.

SnapPlus will always check NA, manually correct if it is a siting plan.

SnapPlus checks yes if Avg. Soil Loss is less than “T” for all fields in the planning year.

SnapPlus checks yes because SnapPlus does not allow winter fertilizer applications.

SnapPlus checks yes if any calibration method is selected on the Farm screen.

 SnapPlus checks yes if field borders are present in SnapMaps for all active fields listed. If not, it will be left blank.

 NA

N and P2O5 applied 
as corn starter 
fertilizer need to 
be at planting and 
placed subsurface

SnapPlus does not 
check for pasture 
exceptions

SnapPlus checks yes if there are no N or P2O5 over-application problems for any field in the current plan year.

SnapPlus auto fills farmer and consultant contact names.

SnapPlus checks yes if all fields comply with soil test requirements in the plan year (not too few or too old).

SnapPlus checks yes if the “Remaining volume” for every nutrient source is less than or equal to 
10% of the “Available Annual Volume” produced in the prior, current plan and following year.  
It will be left blank if any of the 3 years is missing the annual volume or planned applications.

SnapPlus checks yes if there are no compliance messages for the chosen  
P assessment strategy. These strategies do not apply to fields that only receive  
P2O5 fertilizer with no manure or organic by-products during the rotation.

For 1.l. and 1.m., 
mark yes if features 

are mapped

For 1.k., if any field 
has unrepaired 

gully/ephemeral 
erosion in Field 

Problems, SnapPlus 
checks no

Mark yes, no or NA.

SnapPlus 590 NM Checklist Report  
Answers for the plan year are automatically entered 
in the report setup. Be sure to check all answers and 
fill in any blanks.  Use the header sections to add 
comments. 
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 Yes No NA 
n. Make no untreated manure applications to areas within 1000’ of a community potable water well or within 100’ of a 

non-community potable water well (ex. church, school, restaurant) unless manure is treated to substantially eliminate 
pathogens. 

☐ ☐ ☐ 

o. Make no manure applications to areas locally delineated by the Land Conservation Committee or in a conservation 
plan as areas contributing runoff to direct conduits to groundwater unless manure is substantially buried within 24 
hours of application. 

☐ ☐ ☐ 

p. Make no applications of late summer or fall commercial N fertilizer to the following areas UNLESS needed for 
establishment of fall seeded crops OR to meet A2809 with a blended commercial fertilizer. Commercial fertilizer N 
applications shall not exceed 36 lbs. N/acre on:  
• Sites vulnerable to N leaching PRW Soils (P=high permeability, R= bedrock < 20 inches, or W= wet < 12 inches to apparent water table);  
• Soils with depths of 5 feet or less to bedrock;  
• Area within 1,000 feet of a community potable water well. 

   On P soils, when commercial N is applied for full season crops in spring and summer, follow A2809 and apply one of 
the following:   

1. A split or delayed N application to apply a majority of crop N requirement after crop establishment.   
2. Use a nitrification inhibitor with ammonium forms of N.   
3. Use slow and controlled release fertilizers for a majority of the crop N requirement applied near the time of planting. 

☐ ☐ ☐ 

q. Limit manure applications in late summer or fall using the lesser of A2809 or the following 590 rates on PRW Soils.    
    Use ≤ 120 lbs. available N/acre on:   
     P and R soils on all crops, except annual crops. Additionally, manure with ≤ 4% dry matter (DM) wait until after soil temp. 

< 50°F or Oct. 1, and use either a nitrification inhibitor OR surface apply and do not incorporate for at least 3 days. 
    W soils or combo. W soils on all crops.  Additionally, manure with ≤ 4% DM on all crops use at least one of the following:  

1. Use a nitrification inhibitor; 2. Apply on an established cover crop, an overwintering annual, or perennial crop;        
3. Establish a cover crop within 14 days of application; 4. Surface apply & don’t incorporate for at least 3 days;             
5. Wait until after soil temp. < 50°F or Oct. 1. 

    Use ≤ 90 lbs. available N/acre on:   
    P and R soils on annual crops wait until after soil temp. < 50°F or Oct. 1.  Additionally, manure with ≤ 4% DM use either a 

nitrification inhibitor OR surface apply and do not incorporate for at least 3 days.  
    W soils or combination W soils receiving manure with ≤ 4% DM on all crops. 

☐ ☐ ☐ 

r. Use at least one of the following practices on non-frozen soils for all nutrient applications within Surface Water Quality 
Management Area (SWQMA) = 1000’ of lakes/ponds or 300’ of rivers:  1. Maintain > 30% cover after nutrient application;         
2. Effective incorporation within 72 hours of application;  3. Establish crops prior to, at, or promptly following 
application;  4. Install/maintain vegetative buffers or filter strips; 5. Have at least 3 consecutive years no-till for 
applications to fields with < 30% residue (silage) and apply nutrients within 7 days of planting. 

☐ ☐ ☐ 

s. Limit mechanical applications to 12,000 gals/acre of unincorporated liquid manure or organic by-products with 11% or 
less dry matter where subsurface drainage is present OR within SWQMA.  Wait a minimum of 7 days between 
sequential applications AND use one or more of the practice options on non-frozen soils listed in 1.r.1. through 1.r.5.   

☐ ☐ ☐ 

2. When frozen or snow-covered soils prevent effective incorporation, does the plan follow these requirements for winter applications 
of all mechanically applied manure or organic by-products?  This section doesn’t apply to winter gleaning/pasturing meeting 590 N and P requirements.  

      
If no manure is applied, check NA for 2.a. through 2.g.. Yes No NA 
a. Identify manure quantities planned to be spread during the winter, or the amount of manure generated in 14 days, 

whichever is greater.  For daily haul systems, assume 1/3 of the manure produced annually will need to be winter applied. ☐ ☐ ☐ 

b. Identify manure storage capacity for each type applied and stacking capacity for manure ≥ 16% DM if permanent 
storage does not exist. ☐ ☐ ☐ 

c. Show on map and make no applications within the SWQMA. ☐ ☐ ☐ 
d. Show on map and make no surface applications of liquid manure during February and March where Silurian dolomite 

is within 60 inches of the soils surface OR where DNR Well Compensation funds provided replacement water supplies 
for wells contaminated with livestock manure. 

☐ ☐ ☐ 

e. Show on map and make no applications of manure within 300 feet of direct conduits to groundwater.  ☐ ☐ ☐ 
f. Do not exceed the P removal of the following growing season’s crop when applying manure.  Liquid manure 

applications are limited to 7,000 g/acre.  All winter manure applications are not to exceed 60 lbs. of P2O5/acre. ☐ ☐ ☐ 

g. Make no applications of manure to fields with concentrated flow channels unless using two of the following:   
1. Contour buffer strips or contour strip cropping;  2. Leave all crop residue and no fall tillage;  3. Apply manure in intermittent 
strips on no more than 50% of field;  4. Apply manure on no more than 25% of the field waiting a minimum of 14 days between 
applications;  5. Reduce manure app. rate to 3,500 gal. or 30 lbs. P2O5, whichever is less;  6. No manure application within 200 feet 
of all concentrated flow channels;  7. Fall tillage is on the contour and slopes are lower than 6%. 

    Make no applications to slopes greater than 6% (soil map units with C, D, E, and F slopes) unless the plan documents that no other 
accessible fields are available for winter spreading AND two of the options 2.g.1. through 2.g.5. are used.   

☐ ☐ ☐ 

I certify that the plan represented by the answers on this checklist complies with Wisconsin’s NRCS 2015-590 NM Standard or is otherwise noted.   

             
Qualified NM planner signature         NAICC-Certified Professional Crop Consultant, ASA-Certified Crop Adviser, or SSSA-Soil Scientist                                                    Date 

                          
Qualified NM farmer-planner or Authorized farm operator signature                                                   Date 
receiving and understanding the plan 

Signature if reviewed for quality assurance                   Date 
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 Yes No NA 
n. Make no untreated manure applications to areas within 1000’ of a community potable water well or within 100’ of a 

non-community potable water well (ex. church, school, restaurant) unless manure is treated to substantially eliminate 
pathogens. 

☐ ☐ ☐ 

o. Make no manure applications to areas locally delineated by the Land Conservation Committee or in a conservation 
plan as areas contributing runoff to direct conduits to groundwater unless manure is substantially buried within 24 
hours of application. 

☐ ☐ ☐ 

p. Make no applications of late summer or fall commercial N fertilizer to the following areas UNLESS needed for 
establishment of fall seeded crops OR to meet A2809 with a blended commercial fertilizer. Commercial fertilizer N 
applications shall not exceed 36 lbs. N/acre on:  
• Sites vulnerable to N leaching PRW Soils (P=high permeability, R= bedrock < 20 inches, or W= wet < 12 inches to apparent water table);  
• Soils with depths of 5 feet or less to bedrock;  
• Area within 1,000 feet of a community potable water well. 

   On P soils, when commercial N is applied for full season crops in spring and summer, follow A2809 and apply one of 
the following:   

1. A split or delayed N application to apply a majority of crop N requirement after crop establishment.   
2. Use a nitrification inhibitor with ammonium forms of N.   
3. Use slow and controlled release fertilizers for a majority of the crop N requirement applied near the time of planting. 

☐ ☐ ☐ 

q. Limit manure applications in late summer or fall using the lesser of A2809 or the following 590 rates on PRW Soils.    
    Use ≤ 120 lbs. available N/acre on:   
     P and R soils on all crops, except annual crops. Additionally, manure with ≤ 4% dry matter (DM) wait until after soil temp. 

< 50°F or Oct. 1, and use either a nitrification inhibitor OR surface apply and do not incorporate for at least 3 days. 
    W soils or combo. W soils on all crops.  Additionally, manure with ≤ 4% DM on all crops use at least one of the following:  

1. Use a nitrification inhibitor; 2. Apply on an established cover crop, an overwintering annual, or perennial crop;        
3. Establish a cover crop within 14 days of application; 4. Surface apply & don’t incorporate for at least 3 days;             
5. Wait until after soil temp. < 50°F or Oct. 1. 

    Use ≤ 90 lbs. available N/acre on:   
    P and R soils on annual crops wait until after soil temp. < 50°F or Oct. 1.  Additionally, manure with ≤ 4% DM use either a 

nitrification inhibitor OR surface apply and do not incorporate for at least 3 days.  
    W soils or combination W soils receiving manure with ≤ 4% DM on all crops. 

☐ ☐ ☐ 

r. Use at least one of the following practices on non-frozen soils for all nutrient applications within Surface Water Quality 
Management Area (SWQMA) = 1000’ of lakes/ponds or 300’ of rivers:  1. Maintain > 30% cover after nutrient application;         
2. Effective incorporation within 72 hours of application;  3. Establish crops prior to, at, or promptly following 
application;  4. Install/maintain vegetative buffers or filter strips; 5. Have at least 3 consecutive years no-till for 
applications to fields with < 30% residue (silage) and apply nutrients within 7 days of planting. 

☐ ☐ ☐ 

s. Limit mechanical applications to 12,000 gals/acre of unincorporated liquid manure or organic by-products with 11% or 
less dry matter where subsurface drainage is present OR within SWQMA.  Wait a minimum of 7 days between 
sequential applications AND use one or more of the practice options on non-frozen soils listed in 1.r.1. through 1.r.5.   

☐ ☐ ☐ 

2. When frozen or snow-covered soils prevent effective incorporation, does the plan follow these requirements for winter applications 
of all mechanically applied manure or organic by-products?  This section doesn’t apply to winter gleaning/pasturing meeting 590 N and P requirements.  

      
If no manure is applied, check NA for 2.a. through 2.g.. Yes No NA 
a. Identify manure quantities planned to be spread during the winter, or the amount of manure generated in 14 days, 

whichever is greater.  For daily haul systems, assume 1/3 of the manure produced annually will need to be winter applied. ☐ ☐ ☐ 

b. Identify manure storage capacity for each type applied and stacking capacity for manure ≥ 16% DM if permanent 
storage does not exist. ☐ ☐ ☐ 

c. Show on map and make no applications within the SWQMA. ☐ ☐ ☐ 
d. Show on map and make no surface applications of liquid manure during February and March where Silurian dolomite 

is within 60 inches of the soils surface OR where DNR Well Compensation funds provided replacement water supplies 
for wells contaminated with livestock manure. 

☐ ☐ ☐ 

e. Show on map and make no applications of manure within 300 feet of direct conduits to groundwater.  ☐ ☐ ☐ 
f. Do not exceed the P removal of the following growing season’s crop when applying manure.  Liquid manure 

applications are limited to 7,000 g/acre.  All winter manure applications are not to exceed 60 lbs. of P2O5/acre. ☐ ☐ ☐ 

g. Make no applications of manure to fields with concentrated flow channels unless using two of the following:   
1. Contour buffer strips or contour strip cropping;  2. Leave all crop residue and no fall tillage;  3. Apply manure in intermittent 
strips on no more than 50% of field;  4. Apply manure on no more than 25% of the field waiting a minimum of 14 days between 
applications;  5. Reduce manure app. rate to 3,500 gal. or 30 lbs. P2O5, whichever is less;  6. No manure application within 200 feet 
of all concentrated flow channels;  7. Fall tillage is on the contour and slopes are lower than 6%. 

    Make no applications to slopes greater than 6% (soil map units with C, D, E, and F slopes) unless the plan documents that no other 
accessible fields are available for winter spreading AND two of the options 2.g.1. through 2.g.5. are used.   

☐ ☐ ☐ 

I certify that the plan represented by the answers on this checklist complies with Wisconsin’s NRCS 2015-590 NM Standard or is otherwise noted.   

             
Qualified NM planner signature         NAICC-Certified Professional Crop Consultant, ASA-Certified Crop Adviser, or SSSA-Soil Scientist                                                    Date 

                          
Qualified NM farmer-planner or Authorized farm operator signature                                                   Date 
receiving and understanding the plan 

Signature if reviewed for quality assurance                   Date 

 

SnapPlus checks NA if all field borders are in counties with no locally delineated layers (most users). SnapPlus leaves this blank if 
field borders intersect or are in locally delineated county layers; answer yes or no.

SnapPlus checks yes if all fields comply with listed commercial 
fertilizer nitrogen application requirements on areas vulnerable 

to N leaching to groundwater.

SnapPlus checks yes if all fields comply with listed manure 
application nitrogen requirements on areas vulnerable to  

N leaching to groundwater.

SnapPlus checks yes if all fields with SWQMAs comply with at least 1 of the 5 listed practices.

SnapPlus checks yes if surface applications of liquid manure do 
not exceed 12,000 gallons per acre per application where fields 

have tile drainage or intersect SWQMA boundaries.

SnapPlus checks yes if field borders are present; all winter manure applications can only be planned 
in the winter spreadable area of the field and not in the winter prohibited spreading area. 

SnapPlus checks yes if two practices are planned for all winter applications for fields with concentrated flow channels or slopes > 6%.

Yes, electronic signatures can be used for the 2015-590 NM Checklist!   
The intention of the signature block is to ensure the farmer understands the 2015-590 Standard, some requirements are new.  Since the 
form is a fillable Word document and a SnapPlus report, it makes sense to use an electronic signature.  As noted in Wisconsin Statute, an 
electronic signature satisfies the signature requirement of the 2015-590 Checklist. s. 137.15, (3) and (4), Wis. Stats. 137.15(3).

If the farm  
has  
no manure 
and/or 
no winter 
spreading,  
SnapPlus  
will check NA.

SnapPlus checks NA; unless areas intersect any field, then SnapPlus checks yes and provide appropriate guidance.

SnapPlus checks yes if winter manure applications occur and are in compliance with the standard.  

SnapPlus leaves blank. Mark yes, no or N/A.  Answer yes if all public wells are mapped; buffer areas for community (municipal) and 
non-community (public) wells are taken out of manure spreadable acres; treated manure sources can be applied.  

Mark yes, no or NA.

Mark yes or no.

Add comments and explanations for the plan in this section. If necessary, attach a separate page.
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I need to spread manure...but am not sure about runoff. 

Is the local weather the best source for information?
No, there is a better source! The Runoff Risk Advisory Forecast (RRAF) is a tool built by the National Weather Service and 

UW-Madison to predict manure runoff potential and present it in a user-friendly map.  

The runoff forecast provides maps showing short-term runoff risk for daily planning, accounting for factors including 

soil moisture, weather forecast, crop cover, snow cover and slope. It is updated four times daily by the National Weath-

er Service. The data is shown using four-kilometer grids (1.5 square mile), allowing users to look at conditions at a very 

local level. The RRAF is not a regulatory tool and is intended to help farms avoid manure runoff problems by assess-

ing the risk of runoff before they make applications. The map displays 

the runoff risk not just for the current day, but 72 hours into the future 

based on precipitation model forecasts. In the winter, the model looks 

up to 10 days ahead using the temperature forecast to predict snow-

melt. This ‘look ahead’ allows better short-term planning of manure and 

other nutrient applications. 

Other helpful information on the Runoff Risk Advisory Forecast site:

 X Prediction maps for precipitation, soil temperature, and soil moisture

 X Snapshots of past RRAF maps by date and time of day

 X Guidance on what to do if you must spread when the RRAF  
indicates a high risk of runoff.

In the winter, the model 
looks out up to 10 days using 
the temperature forecast to 
predict snowmelt.

The map displays the runoff 
risk not just for the current 
day, but 72 hours into the 
future based on precipitation 
model forecasts.

http://www.manureadvisorysystem.wi.gov/runoffrisk/index

Runoff  Risk Advisory Forecast	 28

28


	Website and resources	2
	How-to videos	3
	Explanations and tips	5
	Tips for plans with manure	7
	Tillage information	8
	Excess N application info	9
	The rotation wizard	10
	Restriction flags	11
	Pastures	12
	Glossary	14
	SnapMaps	15
	NM checklist and tips	24
	Runoff Risk Advisory Forecast	28

